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1. Introduction 

1.1. IN THIS GUIDE 

Condition-Based Monitoring (CBM) with the Intelitek CIM System is designed to help future engineers 
and technicians learn about the world of CBM and how it applies to manufacturing machines. This guide 
consists of the following sections: 

• A list of recommended prerequisites, which is located on page 6. 

• A helpful section on the background theory of CBM, as well as an overview of the relevant 
hardware components. This section begins on page 7.  

• A collection of safety guidelines, which is found on page 14. 

• Instructions for setting up the monitoring software and performing the exercises. These 
directions start on page 15 and includes a list of required materials. 

• Lessons on CBM theory and lab activities to be performed using the training system. These start 
on page 18 and make up most this guide.  
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2. Recommended Prerequisites 
This experiment guide offers background information about predictive maintenance and the condition-
based monitoring of machines. It also discusses parts of the CIM system and how CBM can be applied. 
However, for a more in-depth view of these subjects, it is recommended that all lab participants 
complete the following Intelitek courses: 

Course Name Part Number 

Introduction to Industry 4.0 88-3301-0010 

Introduction to Internet of Things and Connectivity 88-3301-0011 

Smart Devices for Industry 4.0 88-3300-0001 

JobMaster Mechanical Maintenance Series 88-ME##-0001 
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3. General Background Information 

3.1. MANUFACTURING MACHINES AND THE NEED FOR CBM 

3.1.1. Manufacturing Machines 

Modern manufacturing runs on machinery. If it wasn’t for the machines that cut, grind, print, cool, 
weave, press, mold, and package, manufacturing would still be stuck in the 18th Century. 

One of the great things about today’s manufacturing machines is that they are mostly automated, can 
work around the clock, and efficiently produce the parts, materials, textiles, and products that 
consumers all crave with an incredible speed and unrivaled yield. 

 

A CNC turning machine (lathe) cutting a metal part 

One of the harsh realities when it comes to manufacturing machines is that these machines need to be 
maintained. They might need a little lubrication here and there. They might have some bolts that need 
fastening. They might have a belt that needs inspection. At times, they may even break down 
completely and need to be fixed. 

In any event, when a machine is being maintained, it cannot be operated. And that, is bad for business. 

Any period of time that a machine is not in operation is known as downtime. During a machine’s 
downtime, nothing can be produced from that machine, and the manufacturing company ends up losing 
money. Downtime must be limited as much as possible.   

How can downtime be limited? That’s one of the jobs of CBM – Condition Based Monitoring.  
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3.1.2. Machine Parts Overview 

In general, machines require maintenance. Specifically, it is the machine components that need 
maintenance. This section provides a brief overview of common machine parts.  

Motors 

A motor is an electro-mechanical device that converts electrical energy into mechanical motion. In 
industrial machinery, motors serve as power sources to drive and control the movement of components 
such as conveyor belts, pumps, and fans. A motor’s speed is regulated by its controller. 

 

Shafts 

Shafts are cylindrical rods that transmit power or motion from one machine component to another or 
from one machine to another. 
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Couplings 

A coupling is used to connect two shafts together at their ends for the purpose of transmitting power. It 
enables the transfer of rotary motion between the shafts while accommodating misalignments and 
providing flexibility. There are several different types, including rigid couplings, flex couplings, grid 
couplings, and jaw couplings. A yellow rigid coupling is shown in the image below. It connects a shaft to 
a motor.  

 

Bearings 

Bearings support the movement of rotating parts within a machine, such as a shaft. It reduces friction 
between the moving parts, allowing them to move smoothly. Bearings are essential for ensuring proper 
functionality and longevity of the machine by minimizing wear and facilitating efficient rotation. 
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Bearing Blocks and Pillow Blocks 

Bearing blocks and pillow blocks are components that house bearings and allow them to be mounted on 
different surfaces. They help ensure that the bearings are properly aligned. Can you see the bearing in 
the image below? 

 

Gears and Gearboxes 

Gears are toothed wheels that mesh together to transmit rotational motion and power. They play a 
critical role in controlling speed, torque, and direction in machines. Gears are often assembled into 
gearboxes.  

Gearboxes, like the one shown below, changes the speed or torque (rotational force) of an input source, 
like a motor, into a different speed or torque output. They are commonly used in industrial machinery to 
match the speed and power requirements of different parts of a machine or process. 
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Belts and Chains 

Belts (below left) are used with pulleys to connect rotating components and transmit motion and power. 
Chains (below right) do the same, but they are used with sprockets (similar to gears), not pulleys. 

  

3.1.3. Approaches to Maintenance 

There are three primary approaches to machine maintenance: 

• Reactive Maintenance: In this approach, also known as run-to-failure, the machine runs without 
maintenance until a failure occurs. It can be cost-effective initially but is extremely risky. After a 
failure occurs, the cost to repair the machine or the machine component will be higher than any 
other maintenance approach. 

• Preventative Maintenance: Also called scheduled maintenance, this approach involves 
performing maintenance activities at regular intervals, irrespective of the actual machine 
condition. If your maintenance intervals are too frequent, you waste money because of too 
many planned shutdowns and because you replace parts that don’t need replacement. If the 
intervals are too far apart, you risk machine failure. 

• Predictive Maintenance: In this method, repairs to the machine are only done as needed. There 
is an understanding of when a failure will occur, but as long as the machine is still safe for use, it 
will continue to be used until a convenient planned downtime period. This is the most beneficial 
and cost-effective approach, but it requires the greatest initial investment. 

3.1.4. The Need for Condition-Based Monitoring (CBM) 

The approach that helps companies implement predictive maintenance is machine condition monitoring, 
which is also known more commonly as condition-based monitoring (CBM). CBM refers to the 
continuous monitoring of the condition of equipment or systems. 

However, the term CBM goes beyond just facilitating predictive maintenance. It involves collecting and 
analyzing data from various sensors to assess the health and performance of assets. Condition-based 
monitoring can include not only maintenance aspects but also broader monitoring for performance, 
efficiency, and other relevant factors. 
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3.2. SENSORS 

3.2.1. What are Sensors? 

How can we determine the condition of a machine, or specific parts of a machine, at any given time? 
The answer is: we use sensors. 

Sensors are devices which gather information from the surrounding environment and convert it into 
electrical signals. They can be found all around us: they are in our phones, cars, houses, and shopping 
centers. Naturally, they are heavily used in the manufacturing industry. 

3.2.2. Sensors in CBM 

Sensors play a vital role in CBM by continuously monitoring machine conditions. They are placed in 
strategic locations on the machine and detect changes in factors like vibration, temperature, and 
performance. The collected data is then sent to a computer system, which analyzes patterns and 
trends. By interpreting these signals, CBM can predict potential issues, allowing for timely and targeted 
maintenance. Sensors, therefore, act as the eyes and ears of CBM, providing real-time insights into the 
health of industrial equipment. 

Modern CBM sensors are smart sensors. For a sensor to be considered “smart”, it must have a physically 
integrated: 

• Sensing element (to measure or detect whatever the sensor is designed to detect or measure) 

• Microprocessor (to handle and convert data) 

• Communication module (to relay the data to other devices) 

Most smart sensors also have self-diagnostic capabilities. This means that they can check themselves at 
regular intervals to see if they are working properly. Another common feature of CBM sensors and their 
accompanying architecture is that the sensor data can be sent to a cloud service and can be viewed 
wherever there is an Internet connection. This also allows for easier storage, aggregation, and analysis 
of data in real time.  

3.2.3. Online and Offline Monitoring 

Sensors used for CBM should ideally be fixed permanently to different locations on the machine and 
constantly send data to the monitoring software. Another way to say this is that sensors should be 
“online.” This is opposed to the “offline” sensors or vibration monitors that you may have used in 
Intelitek’s ME12: Vibration Monitoring course. 
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3.3. THE CBM TRAINING KIT 

The CBM with CIM Training Kit includes several components: 

• The Machine: In the exercises, you will be monitoring the condition of an industrial machine. 
The machine will be represented by the CIM cell’s conveyor motor. The motor is equipped with 
a gearbox, which allows power to be transmitted in the direction of the conveyor. It also slows 
down the rotational speed and increases the torque, which allows the conveyor to move at a 
relaxed speed while being able to transport heavy objects. 

 

• The Motor Controller: The variable-frequency drive, or VFD, controls the speed of the electric 
conveyor motor by adjusting the frequency and voltage of the power supplied to it. For Intelitek 
CIM installations, the motor speed is fixed and cannot be adjusted by students.  

• Sensors and the Diagnostic Device: A collection of sensors is mounted onto the conveyor motor 
assembly, and they are the devices that generate the data for monitoring. There are three types 
of sensors: vibration, temperature, and rotation speed.  The experiment package also includes a 
diagnostic device, which interprets the raw data from the vibration sensors into information 
that is more useful for the machine technician. 

 

• Monitoring Software: The software package included with the diagnostic device allows you to 
set up the system and define the parameters that you want to be monitored. It is also 
visualization software, which means that it can display the data in visual form, such as a graph or 
chart. The interface can also be used to set up warnings and alarms if monitored data rises or 
falls beyond a set limit. 
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4. Safety Guidelines 
Safety precautions in an industrial machine’s working environment serve to protect the human 
technicians as well as the machine and related equipment. Always use caution when working with the 
Intelitek CBM Lab Kit to avoid personal injury and damage to the equipment.  

Be sure to adhere to the following safety guidelines: 

• Ensure that all components are mounted securely unless instructed otherwise.  

• All hardware installations and adjustments are to be performed by or under the supervision of 
the laboratory instructor or the system manager.  

• All wiring connections are to be performed by or under the supervision of the laboratory 
instructor, system manager, or Intelitek System Integrator. Do not approach or touch any 
electrical components or wiring without permission.  

• Do not open or put your hand into the motor assembly. Do not tamper with the motor or any 
other components. 

• If you notice an exposed, cut, or frayed wire, report it to your instructor. 

• Ensure that the motor controller’s power supply unit is connected to a rated power supply.  

• Make sure hands, hair, clothing, and jewelry are securely away from the machine’s working 
area. If you have long hair, tie it back so that it does not get caught in any devices. Avoid wearing 
hanging jewelry and loose-fitting clothing. 

• Ensure that the safety system is operational before running the motor at high speeds (if relevant 
to your system). 

• Always maintain a clean work area. Keep food and drink away from the work area.  

• Read all directions before starting a task. It is recommended to read all of the relevant 
automation manufacturer’s documentation before operating any hardware, using software, or 
performing any tasks.  

• If you are unsure of how a certain system works, talk to your instructor before operating the 
related equipment. 
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5. Hardware Setup 

5.1. REQUIRED MATERIALS 

The following materials are required for completion of the lab activities: 

Component Part Number Quantity Notes 

CIM cell conveyor gear motor K430956 1 Functional and mounted onto the conveyor 

Vibration (acceleration) sensor 410565 4  

Magnetic mount for vibration sensors  410566 4  

Magnetic sensor 410570 1 For rotational speed monitoring 

Damping magnet for magnetic sensor 410571 1  

Temperature sensor 410568 1  

Temperature sensor signal converter 410569 1  

Diagnostic device 410564 1 VSE003 Diagnostic Electronics 

Sensor wiring and connection cables 
410567, 
410572 

 
 

Ethernet cable 3 m 411931 1  

Personal computer N/A 1  

The following software is required for completion of the lab activities: 

Component Part Number Quantity Notes 

VES004  1 Version 2.33 or higher 
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5.2. SETUP 

All installations must be performed by Intelitek system integrators or certified instructors.  

• Three of the four vibration sensors are to be placed on the X, Y, and Z directions of the motor as 
shown. 

 

• The fourth vibration sensor is to be placed on a position to be determined. In the first lab 
activity, it is placed on the front panel of the conveyor motor assembly.  
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• The temperature sensor probe is placed on a bolt or stud, either on the motor or the gearbox. 

 

Example temperature probe placement 

• The magnetic (rotation speed) sensor (A) and the damping magnet (B) are affixed to one of the 
rollers of the conveyor.  

 

A 
B 
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6. Lesson 1: Introduction to Vibration 

Monitoring  

6.1. IN THIS LESSON 

6.1.1. Overview 

In this lesson, you will be introduced to the concept of vibration in industrial machines and to vibration 
analysis in general.   

6.1.2. Performance Objectives 

After completing this lesson, you will be able to:  

• Define vibration with regard to industrial machinery. 

• List ways in which vibrations are measured and analyzed. 

6.2. BACKGROUND INFORMATION  

6.2.1. The Importance of Vibration Monitoring in CBM 

As you saw in the general introduction, different types of sensors are used in CBM, but the most 
important sensor is the vibration sensor. This is because vibration monitoring and analysis has the 
potential to find machine faults before any other type of sensor and before the machine comes even 
remotely close to running to failure. 

6.2.2. What is Vibration? 

Rotating machines vibrate when running, and you can hear a sound. This is because sound itself is 
vibration. When you speak, your vocal cords generate vibrations which are transmitted through the air 
to other people’s ears.  

When the amplitude of vibration is high enough, vibration can even be seen. However, vibrations in 
machinery should not have an amplitude that is large enough to be visibly seen by the human eye. 

When it comes to machines (and music) the vibration produced by the equipment (or instrument) can 
be detected and then transmitted as a vibration signal, which can be viewed graphically. The signal 
appears as a waveform. 

 

Recorded sound waves 
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6.2.3. A More Precise Definition 

What exactly is vibration? 

Vibration is the mechanical oscillation of an object about a resting position. 

When an object vibrates, it moves rapidly back and forth between two extremes. If you place your hand 
on a working machine, you can feel the vibrations. If you were to observe a point on the surface of a 
vibrating object, you would see it move back and forth a small distance. This back and forth (or 
oscillatory) movement is why the vibration signal is a waveform. 

In most systems, vibration is considered a waste of energy. Moving an object back and forth, even over 
tiny distances, requires energy. Any energy used in vibration is energy not going into the intended 
process of the machine. This is one reason technicians attempt to minimize vibration. Another reason is 
that vibration can cause damage to machines and their parts. 

 

6.2.4. Detecting Vibration 

Your vibration sensors are actually acceleration sensors. They measure vibrations by detecting the 
acceleration (change of velocity) of a specific point where they are mounted. Inside each sensor, there 
are tiny components called piezoelectric elements that respond to mechanical vibrations. When the 
sensor experiences movement – shaking or vibration - these elements generate electrical signals 
proportional to the acceleration forces acting on them. The signals are then processed by the diagnostic 
device and displayed on the monitoring software screen. 
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You can think of the vibration sensors and the type of data that they produce as a type of 
echocardiogram or stethoscope for machines. These devices listen to the sound waves of the beating 
heart and present this data in a way that helps doctors find abnormalities. 

Similarly, acceleration sensors listen to and feel the vibrations of the machine to help find defects. 

6.2.5. Sensor Placement 

A piece of machinery will weigh the same amount no matter how you place it on a scale. However, 
vibration is not uniform throughout a single machine. It can vary from surface-to-surface, or even 
depends on the axis of a measurement. 

Possible points of measurement of a typical machine include:  

• On the top, front, rear, or sides of the motor body. 

• On motor bolts or studs. 

• On the motor foundation (the surface the motor is resting on). 

• On top of motor feet. 

• On the front or sides of mounting blocks, pillow blocks, or bearing housing. 

• On the front or sides of gear boxes. 

Sensors must not be placed on rotating or moving components such as motor shafts, belts, or gears. 

6.2.6. Axis of Vibration Readings 

In addition to location, the axis of measurement is also important. 

Vibration readings can be significantly different in the X, Y, and Z directions at any given point. The X 
and Y directions make up the horizontal plane, while Z is the vertical axis.  

When measuring vibration on components that support or drive a rotating shaft, measurements are 
typically referred to as axial and radial, where axial is parallel to the axis of rotation and radial is 
perpendicular to it. 
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6.2.7. Consistency in Sensor Placement 

When measuring vibration of a machine for maintenance purposes, it is important that the same spot is 
measured every time for the sake of consistency. There are several methods to taking consistent, 
repeated measurements. Many vibration sensors and probes come with threaded holes that can be 
attached to studs on a machine. Small steel pads can also be welded to the surface of machinery for use 
with magnetic probes. One of the simplest methods is to mark locations with a permanent marker or 
paint. 

When using true CBM monitoring practices with fixed sensors, the same spot is measured constantly 
because the sensor is online (constantly sending measurements to the system) and doesn’t move. 

6.2.8. Acceptable Vibrations 

What exactly is a “good” vibration measurement? How do you know if the vibrations of your machine 
are acceptable or if there is a problem? If you’ve taken the Intelitek Mechanical Training series 
(including the ME12: Vibration Analysis course), you may be familiar with vibration severity charts like 
the one shown below. In general, these charts can help determine if a machine has been installed 
correctly.  

 

The units of the vibration measurement in the above chart are in inches per second (in/s) or millimeters 
per second (mm/s). These are units of velocity – and tell us how fast the machine is vibrating at the 
point of measurement. 
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Severity charts can also list vibrations relative to the rotational speed of the machine. The severity chart 
below, taken from ISO standard 10816-4, is for radial measurements of bearing housings on the shafts 
of gas turbines. Higher rotational speeds have lower vibration tolerances in this particular chart.  

 

Note that the units of vibration measurement here are not velocity units. They are displacement units. 
They show how much distance the measured point should or shouldn’t move. 
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6.2.9. Vibration Measurements 

How can you measure velocity or displacement with an acceleration sensor? Actually, the sensor 
measures the vibration value in acceleration units, but the diagnostic device converts that value into a 
velocity or displacement value.  

All three types of these amplitude vibration intensity measurements are used in vibration analysis. 
This is because some types of machine faults are easier to find using displacement values, other types of 
faults are best found using velocity values, while still others are most efficiently detected using 
acceleration values. 

Vibration Intensity (Amplitude) Measurements 

Term Definition Units 

Displacement (d) Distance from a central position during vibration. µm, mm, or in 

Velocity (v) Rate of change of displacement over time. mm/s or in/s 

Acceleration (a) Rate of change of velocity over time. mm/s2, in/s2 or mg* 

*Vibration can be expressed in units of the gravitational constant, g, where 1 g = 9.81 m/s2. 

Velocity measurements together with a vibration severity chart can help us know if there is a problem 
during machine installation, but more advanced vibration analysis, together with condition monitoring, 
can help us detect the exact problem or condition that a machine component may be experiencing at 
any given point.  

To understand vibration analysis, however, we must look deeper into the vibration measurements that 
CBM sensors can give us, as we do in the upcoming sections.  
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6.2.10. The Vibration Signal Waveform 

We’ve seen that vibration is repetitive motion around a central point. The resultant output signal is a 
waveform. The waveform has several characteristics, the two most important of which are amplitude 
and frequency. 

Amplitude 

Amplitude is the maximum distance that an object moves from its central (equilibrium) position during 
vibration. It represents the intensity or strength of the vibration. As we learned previously, the 
measured amplitude can be displacement, velocity, or acceleration.   

In the graphic below, vibration signal A has a higher amplitude than vibration signal B. 

 

Frequency 

Frequency (f) is the rate at which the object oscillates (completes a cycle of motion) per unit of time. It is 
measured in Hertz (Hz), representing the number of cycles per second. Higher frequencies (such as in 
the bottom wave) indicate faster oscillations or vibrations. In the graphic below, vibration signal B has a 
greater frequency than vibration signal A.  

 Note: Frequencies can also be measured in cycles per minute or CPM. 1 Hz = 60 CPM. 
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6.2.11. Definitions of Amplitude 

We’ve learned that amplitude is the maximum extent of a repeating vibration event. There are various 
definitions of amplitude which are all functions of the difference between the extreme values. They are 
all used in vibration analysis.  

• Peak-to-Peak (P-P): The total distance (on the waveform – not necessarily displacement) 
between the maximum positive and maximum negative vibration points in a cycle. 

• Zero-to-Peak (0-P): The distance from the zero (or equilibrium) position to the highest point of 
vibration in one direction (either positive or negative). 

• Root Mean Square (RMS): 1/√2 (about 0.7) of the 0-P amplitude. Because vibration is a 
waveform, there are both positive and negative values for displacement, velocity, and 
acceleration. RMS is used for getting an average, positive value.  

 

Because vibration amplitude can be measured in acceleration (a), velocity (v), and displacement (d), 
each of the three definitions for amplitude can be further subdivided by measurement type. For 
example, a-P-P is the peak-to-peak acceleration, d-RMS is the root mean square of the displacement 
vibration amplitude, and v-0-P would be the zero-to-peak velocity.  
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6.2.12. Displaying Vibration Signals 

There are two main ways to display a vibration signal: using the time domain or the frequency domain.  

Time Domain (Raw Data) 

The first is the way that you have already seen: the time domain view. It is also called the time 
waveform. For the displacement value, it is a pure view of the sensor’s total movement over time. For 
the other quantities (velocity and acceleration) it is their pure record of change over time. 

Until now, you’ve been looking at vibration signals as if they were a single, clean sinusoidal wave. In 
reality, vibration signals are not nearly as immaculate. If you were to take a raw vibration signal from a 
rotating machine, it may look like the one shown below.  

 

There are waves upon waves of vibration signals, and aside from the general amplitude, it is difficult to 
determine which part of the machine is causing which component of the vibration signal.  

Using mathematical manipulation such as the RMS calculation, we are able to understand it somewhat. 
However, there are different ways to view vibration signals and how to understand them. 
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Frequency Domain 

The second data display type is the frequency domain view which is also called the spectrum. It is the 
view of each frequency component of the sensor’s total movement. The view allows us to see all 
amplitudes of the frequencies that the time waveform is made up of separately. 

In the example below, presenting a certain vibration waveform on the frequency domain results in two 
peaks. At 100 Hz, the vibration (velocity) amplitude is 2 mm/s, while at 200 Hz it is 1 mm/s.  

 

Having an understanding of the distribution of peaks of a frequency spectrum at different machine 
speeds is one common method that allows vibration analysts and CBM technicians to discover faults in 
machines before any serious damage occurs.     

6.3. REVIEW QUESTIONS 

1. Vibration analysis is the primary monitoring tool of CBM because: 

a. It is the easiest to calculate. 

b. Vibration is the easiest phenomenon to detect. 

c. It has the potential to find machine faults before any other type of monitoring. 

d. Because vibration sensors are the least expensive CBM sensor. 

2. Which of the following is NOT a measure of the amplitude of a vibration signal? 

a. Acceleration 

b. Displacement 

c. Frequency 

d. Velocity 
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3. Why is RMS vibration amplitude used? 

a. To obtain the highest amplitude value possible. 

b. To obtain a consistent, positive amplitude value. 

c. To find the frequency of the waveform. 

d. Why not? 

4. Which of the following is a vibration velocity amplitude unit?  

a. mm/s2 

b. mm 

c. mg 

d. in/s 

5. A vibration time waveform plots: 

a. Amplitude against time 

b. Amplitude against frequency 

c. Frequency against time 

d. Frequency against vibration 

6. A vibration spectrum plots: 

a. Amplitude against time 

b. Amplitude against frequency 

c. Frequency against time 

d. Frequency against phase 1:c, 2:c, 3:b, 4:d, 5:a, 6:b 

Answers 
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7. Lesson 2: Working with CBM 

Monitoring Software 

7.1. IN THIS LESSON 

7.1.1. Overview 

Sensors contribute nothing to CBM if there is no way to monitor the data that they send.  

In this activity, you will explore the monitoring software’s user interface and investigate some of its 
main functions. You will also use the CBM monitoring system in your lab for the first time.   

7.1.2. Performance Objectives 

After completing this lesson, you will be able to:  

• Identify the components of the VES004 window.  

• Create a new VES004 project. 

• Connect the project to vibration diagnostic devices. 

• Observe vibration waveforms. 

7.2. BACKGROUND INFORMATION  

7.2.1. What’s Monitoring Software? 

There are many different types of software that fall into the category of condition monitoring. These 
software types may be designed to monitor entire facilities or to just monitor a group of sensors on a 
single machine.  

In any event, all of these software systems are designed to monitor the health and performance of 
equipment and facilities, help detect issues early, prevent failures, and optimize maintenance activities. 

Your monitoring software system, VES004, serves to configure the diagnostic device and display any 
data that it receives from connected sensors. 
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7.2.2. Components of the VES004 Window 

The components of the VES004 window are detailed below.  

 

Label # Component Description 

1 Menu Bar 
The menu bar contains the most important functions of the software. 
These functions are grouped together in menus. Any functions that 
are not available for a selected object are grayed out. 

2 Tool Bar 

The tool bar contains frequently used functions as buttons with 
symbols. Some of the buttons that you will use include the write to 
device option, the connect to device function, and the monitoring 
windows. 

3 Tree View 

Also called the project tree, the tree view contains the devices, 
parameters, settings, and other elements that belong to a project. 
The elements are displayed in groups. You can open the detailed view 
of an element by double-clicking it. 

4 Detailed View 

The detailed view occupies the largest part of the user interface. It 
shows the settings and information of the selected elements from the 
tree view and arranges them in tabs. The settings of each element can 
be edited in the detailed view. 

5 Context Menu 
Most VES0004 elements have a context menu from which related 
functions can be selected. Right-click an element to open its context 
menu. 
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7.2.3. Common Steps for Setting up Data Monitoring 

Setting up monitoring operations on a machine (or a facility with multiple machines) involves several 
steps. Here is a brief summary of the steps:  

1. Get started: Begin by creating a new project. The name should be clear and refer to your facility 

or laboratory area. In your project, add your diagnostic device from the New Device list to the 

tree view. 

2. Get connected: Get connected to the diagnostic device. Your computer and the diagnostic 

device need to be on the same network. The default IP address of diagnostic device is 

192.168.0.1. Ask your instructor or IT manager to help you change the computer’s IP address to 

a static (manual) IP address on the diagnostic device’s network. Once connected to the 

diagnostic device, activate your diagnostic device’s connected sensor(s). 

3. Create a parameter set: A parameter set is a collection of specific elements (called objects) that 

you want to monitor. Peak-to-peak acceleration, v-RMS, and unbalance are examples  

of objects. Parameter sets can also include measurement triggers, alarms, and other types of 

notification and monitoring elements.  

4. Write to the device: Once completed, the parameter set must be written to the device. This is 

also true of any change that you make to the parameters: The project must be saved and the 

parameters written to the device.   

5. Monitor and analyze: Once you have the parameters that you want to monitor on the diagnostic 

device, you can start monitoring and analyzing your data. 

7.2.4. Monitoring Windows 

7.2.4.1. Overview 

There are various ways to monitor sensor data using the VES004 software. 

For some of the monitoring windows, you can switch to various views, including bar graph, table, 
moving data display, and unlimited data display views. The monitoring windows can be accessed from 
the tool bar: 

 

You can also record data and play back the data that you have recorded. 
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7.2.4.2. Raw Data Monitoring 

Even if you do not create a parameter set, you can still view the raw data (time waveform) that a 
vibration sensor is generating. 

The raw data monitoring view displays measured acceleration amplitudes of the sensor (in mg or m/s2) 
against time.  

 

You can also click and drag to zoom in on a specific area of the waveform. 

7.2.4.3. Spectrum Monitoring 

As with raw data monitoring, you do not need any parameters to see the spectrum (frequency domain 
view) of the selected vibration sensor.  

Recall that the spectrum displays the amplitudes of the different frequencies detected by the vibration 
sensor. 
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7.2.4.4. Data (Object) Monitoring 

The data monitoring window displays the data from objects that you define in the parameter set, such 
as v-RMS, peak-to-peak acceleration, unbalance, and others.  

You can also see where each of the object values stand with relation to alarms and warnings. 

 

For each of the objects that you create in your data set, you can also configure limits. VES004 has two 
types of limits: warning and damage, where damage is the most severe.  

For example, if you have an object that is monitoring the v-RMS value (RMS value of the velocity 
component of vibration), you might set the warning limit to 5 mm/s (0.2 in/s) and the damage limit to 8 
mm/s (0.3 in/s). These limits appear in the data monitoring window as yellow and red, respectively.  

You can also set alarms to go off if either of these limits are reached. 

7.2.4.5. Counter Monitoring 

Counters can be configured to count how long sensor values have been in a specific state. The counter 
monitoring window provides an area to monitor the counters that you have created. 

7.2.4.6. I/O Monitoring 

The I/O monitoring window allows you to view the current states of inputs. For example, if you have a 
digital sensor, you can see its switching state (whether it is on or off). For dynamic or analog inputs, such 
as a speed or temperature sensor, you can see their measured values. 

7.2.4.7. History Monitoring 

The history monitoring window reads and displays the internal memory of the diagnostic device. The 
history monitoring window helps to visualize the development of measurements that occurred prior to a 
warning or alarm message. 

7.2.5. Important Notes about the Software 

7.2.5.1. Preferences 

Before you start monitoring your sensor data in VES004, you might want to head over to the Settings 
menu.  

Here, you can change your preferences. One change that you might consider is switching the 
measurement units from Metric to Imperial, or vice versa. 
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In this experiment package, the Metric 1 engineering units are displayed in most of the images and 
videos. Use whatever display options work best for you. 

7.2.5.2. Flexible Methods for Performing Actions 

VES004 is meant to be user friendly, and it often offers several different ways of performing the same 
action.  

For example, in the images below, you can see three different ways of downloading a parameter set to 
the connected device.  

Whenever you need to perform an action, you may use whatever method suits you best even if that 
method is not explicitly mentioned in the lab activity that you are working on. 

 

 
From the element’s (or a higher-level element’s) context menu. 

From the menu bar. 

 
From the tool bar. 
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7.3. LAB ACTIVITY 

In this lab activity, you will create a new project and connect your device to the project. You will then 
check that all of the sensors are working properly and sending data.  

7.3.1. Hardware Setup 

Perform the following steps: 

1. Ensure that the vibration sensors are connected to the diagnostic device at the black sensor 

ports. If they are not, inform your instructor or system integrator.  

 

2. Ensure that diagnostic device is (1) connected via an Ethernet cable to the computer workstation 

and is (2) connected to a power supply via the power cord.  

3. Ensure that the device is powered on. The System LED on the front of the device should be on. 

4. Ensure that all of the vibration sensors are connected. The Sensor 1-4 LEDs on the front of the 

device should be illuminated.    
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5. Ensure that the vibration sensors are located at the following positions:  

▪ Motor axial 

▪ Motor radial - parallel to conveyor 

▪ Motor radial - perpendicular to conveyor 

▪ Front panel of the motor drive assembly     

 

7.3.2. Getting Started with VES004 

In this task, you will create a new VES004 project.  

1. Run VES004.  

 

2. The application may open with the last used project displayed (this is the default setting). In the 

menu bar, select Project > New.  
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3. Give your project a good file name that includes your name or initials in it. Save it in an 

appropriate location, such as your personal folder, and then click OK. If you are then prompted 

to save changes to the current project, select No.  

  

The new project opens with the name of the project in the tree view. An asterisk indicates that 

there have been changes to the project that have not been saved.  

 

4. From the right-side menu bar, select View > Settings.  
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5. In the Common tab, ensure that Automatically open last project used is unchecked, and then 

click OK. 

 

6. If desired, select the Display units tab and change the engineering units. Throughout these lab 

activities, units are displayed in the Metric 1 style.  

 

7. Click OK to confirm the changes and to close the VES004 settings window.  
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7.3.3. Connecting the Devices 

In this task, you will add the diagnostic device to the project and enable communication between it and 
the workstation computer. You will also write a simple parameter set that includes the sensor package.  

1. From the menu bar, select Device > New > Diagnostic electronics > Diagnostic electronics 

VSE003.  

 

The VSE003 diagnostic device is added to the project tree. Its settings tab is displayed in the 

detailed view. Note the default IP address of the device is 192.168.0.1. The workstation must 

also have a static IP address on the same network.  
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2. Click the Connect to the device button.  

 

3. In the project tree, double-click Parameter_01, which is the default name of the diagnostic 

parameter set. You can change the name if desired.  
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The parameter tab is displayed in the detailed view.  

 

4. Add your machine’s information to the fields of the Common configuration > Documentation 

menu. 
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5. Select the parameter’s Inputs menu.  

 

The Inputs menu contains a list of potential sensors that can be connected to the parameter set.  

6. In the Dynamic Inputs, select Dynamic inputs (AC) > Sensor 1.  

 

The Sensor 1 menu is displayed in the detailed view.  
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7. Click the switch at the top-right corner to activate the sensor.  

 

Once active, information about the sensor is shown. Your sensor is type VSA001, one of the 

default types. Note that the engineering unit is g. This is the measuring unit for vibration, and it 

will appear in the amplitude axis of the time waveform (raw data). Recall that g is a unit of 

acceleration. This cannot be changed, because the VSA001 is an acceleration sensor 

(accelerometer). 

 

 Note 1: The default filter is Highpass 2 Hz. We will learn about filters in a future activity. 

 Note 2: Leave the name of the sensor as is. You will return to this menu to rename the sensors 

once they can be better identified.   
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8. Repeat steps 6-7 for the other three vibration sensors.  

 

9. In the Analogue inputs (DC) section, select IN 1. This input will be the magnetic (rotary speed) 

sensor. 

 

10. In the detailed view on the right, activate the sensor. 
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11. In the Identification section, change the Name of the input to Conveyor speed and the Type to 

Digital - pulse.  

 

12. In the Configuration section, keep the default settings.  
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13. In the Analogue inputs (DC) section, select IN 2. This input will be the temperature sensor.  

 

14. Activate the sensor.  

 

15. In the identification area, change the Name to Temperature. Leave the default Type as Analogue 

- current.  

 



  

 

47 

  
 

Condition-Based Monitoring |Experiment Guide|Lesson 2: Working with CBM Monitoring Software 

© 2025 Intelitek Inc. All rights reserved | 34-8000-0026_CBM_for_CIM_v1.5.2 

16. Change the engineering unit to Degrees C or Degrees F.  

17. For the lower and upper reference points, leave the Currents and change the Values to: 

▪ For degrees C  

▪ Lower reference point: -40 Degrees C 

▪ Upper reference point: 140 Degrees C 

▪ For degrees F  

▪ Lower reference point: -40 Degrees F 

▪ Upper reference point: 284 Degrees C 
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18. Select Project > Save (or keyboard shortcut Ctrl+S) to save the project. Note that after saving, 

the asterisks next to the names of the project and parameters disappear.  

 

19. The parameter must be written to the diagnostic device. In the toolbar, click the Write 

parameter to the device button.  

 



  

 

49 

  
 

Condition-Based Monitoring |Experiment Guide|Lesson 2: Working with CBM Monitoring Software 

© 2025 Intelitek Inc. All rights reserved | 34-8000-0026_CBM_for_CIM_v1.5.2 

20. A warning message is displayed. It can be ignored for now. Click Yes.  

 

The parameter is now on the diagnostic device and the sensors data can be processed.  

21. Ensure that the Start project data monitoring button is pressed.  

 

7.3.4. Raw Data and Sensor Identification 

You will now use raw vibration monitoring to help identify each of the vibration sensors. Once they have 
been identified, you will rename them appropriately. Perform the following: 

1. In the toolbar, click the Open raw data monitoring window button.  
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The raw data (time waveform) is displayed. Note that the units of the Y-axis are acceleration 

units. The X-axis is the time axis. The amplitude of vibration is low (because the machine is off). 

The waveform fills the screen, however, because the amplitude scale and range change 

automatically in order to maximize visibility.    

 

 Note: If there is no waveform, click the Start data monitoring button in the top-right corner.  

 

2. Click the arrow on the left side of the Raw data monitoring window to open the left-side menu.  
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Initially, only the data from Sensor 1 is displayed. The other sensors can be selected, but only 

one at a time. 

 

3. While observing the Raw data monitoring window, give each of the four vibration sensors 

several small taps with your index finger. Note which of the sensors causes the greatest change 

in vibration in Sensor 1’s raw data.  

 Pro tip! Remove the sensor from the machine before tapping it in order to get a reliable reading.  
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4. Click the Parameter tab.  

 

5. Select the Sensor 1 input.  

 

6. In the Detailed View, rename Sensor 1 as appropriate. In our setup, Sensor 1 is on the front 

panel of the motor drive assembly.   

  

7. Click the Raw tab to return to the Raw data monitoring window.  

 



  

 

53 

  
 

Condition-Based Monitoring |Experiment Guide|Lesson 2: Working with CBM Monitoring Software 

© 2025 Intelitek Inc. All rights reserved | 34-8000-0026_CBM_for_CIM_v1.5.2 

8. In the left-side menu, select Sensor 2.  

 

The default raw vibration data for Sensor 2 is represented as blue and the amplitude (y) axis is 

on the right side.  

   

 Note: The amplitude axis can be changed to the left side by right-clicking the axis, selecting 

Delete axis in the context menu, and the selecting the sensor again from the left-side menu. 

Additionally, the color and scale of the data/axis can be modified using the options in the right-

side menu. You can also perform other options by right-clicking different elements of this and 

other monitoring windows. 
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9. While observing the raw data monitoring window, give each of the three vibration sensors 

whose identities remain unknown several small taps with your index finger. Note which of the 

sensors causes the greatest change in vibration in Sensor 2’s raw data. 

10. Return to the Parameter tab and modify the name of the Sensor 2 input. In our setup, Sensor 2 

is the sensor on the radial side of the motor perpendicular to the direction of the conveyor. 

 

11. Repeat steps 7-10 for the other two unidentified sensors. Our sensor setup is shown in the 

image below.  

 

12. Save your project.  

13. Write the parameter to the device. Ignore any warnings.  
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14. Ensure that data monitoring is still taking place (and you can see a waveform). If it isn’t, click the 

Start data monitoring button.  

 

15. Click the Switch to table view button.  

 

A list of the vibration sensors and their current acceleration measurement is displayed. Only one 

sensor can be displayed at a time. Sensors can be selected from the left-side menu.   

 

16. Switch back to moving window data view.  
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17. Press the conveyor controller’s START button to turn the conveyor on.  

 

18. Observe the raw data window. Note how vibration amplitude increases. The scale of the 

amplitude axis may change as well.   

 

 Note: In the right-side menu, you can change the scaling type by first clicking the amplitude axis 

and then using the Auto-scaling dropdown menu.   
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 Note: Another way to scale the graph is to click on the graph and drag your cursor to create a red 

box around the section you want to observe more closely. Scroll down on your mouse wheel or 

right-click and select Undo zoom to zoom out.  

  

19. Select the other vibration sensors in the left-side menu and observe how they are affected when 

the conveyor is turned off and on.  

 

20. After testing each acceleration sensor, turn the conveyor off.  

21. Open the I/O monitoring window.  
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A list of I/Os (inputs and outputs) are displayed. The Conveyor speed and Temperature sensors 

should be displayed at the top.  

 

If those inputs are not displayed, open the left-side menu and select them from the list.  
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22. There are four different ways to monitor the I/Os. Check out each of these options now.  

 

23. Return to table view.  

 

24. Turn the conveyor on. Note how the Conveyor speed and Temperature values increase. The 

Conveyor speed should level off quickly, while the temperature will slowly increase as the motor 

gets hotter from use.  

 

25. Turn off the conveyor.  

26. Save the project. You will use it in the upcoming lab activities.  

7.4. REVIEW QUESTIONS 

1. Your monitoring software package is capable of monitoring:  

a. A single diagnostic device. 

b. All diagnostic devices in a small area. 

c. All diagnostic devices in a single facility.  

d. All of the above.  
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2. The image below shows: 

  

a. Raw data 

b. The spectrum 

c. The data monitoring window 

d. The history monitoring window.  
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3. The image below shows: 

  

a. Raw data 

b. The spectrum 

c. The data monitoring window 

d. The history monitoring window.  
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4. The image below shows: 

  

a. The raw data monitoring window 

b. The spectrum monitoring window 

c. The data monitoring window 

d. The history monitoring window.  

5. Based on the image, the measured vibration is:  

 

a. Within limits (valid) 

b. In the warning zone 

c. In the damage zone 

d. Not visible/noticeable 

Answers 

1:d, 2:a, 3:d, 4:b, 5:b 
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8. Lesson 3: Measuring Vibration Severity 

8.1. IN THIS LESSON 

8.1.1. Overview 

In this lesson, you will add objects that monitor vibration severity to your project’s parameter set.  

8.1.2. Performance Objectives  

After completing this activity, you will be able to:  

• Create monitoring objects for vibration severity. 

• Set monitoring limits. 

8.2. BACKGROUND INFORMATION 

Recall from the previous lesson that vibration severity charts like the one shown below are often used 
for machine condition monitoring. Usually, these charts are used to determine if a machine has been 
installed correctly.  

 

The units of the vibration measurement in the above chart are in inches per second (in/s) and 
millimeters per second (mm/s). These are units of velocity – and tell us how fast the machine is 
vibrating at the point of measurement.   
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8.3. LAB ACTIVITY 

In this lab activity, you will create objects to monitor vibration severity and determine if your “machine” 
is within reasonable limits.  

Perform the following procedures: 

8.3.1. Hardware Setup 

For this and subsequent lab activities, it is assumed that the CBM hardware is installed as in Section 
7.3.1 on page 35. See that section for details.  

8.3.2. Adding an Object to the Parameter Set 

In this task, you will create a new object in your existing parameter set. The object will monitor vibration 
severity by calculating and displaying one of the vibration sensor’s v-RMS value.  

1. Run VES004.  

 

2. In the menu bar, select Project > Open. Browse to the project that you created in the previous 

lab activity and open it.  

 

 Note: The project may also be located in the Recent projects menu.  

3. Ensure that you are connected to the diagnostic device. If you are not connected, connect to it 

now.  
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 Note: If the Connect to the device option is greyed out, select the diagnostic device in the project 

tree.  

 

4. In the project tree, double-click the parameter set to open the parameter set’s detailed menu.  

 



  

 

66 

  
 

Condition-Based Monitoring |Experiment Guide|Lesson 3: Measuring Vibration Severity 

© 2025 Intelitek Inc. All rights reserved | 34-8000-0026_CBM_for_CIM_v1.5.2 

5. In the detailed view, right-click Objects to bring up a context menu.  

 

6. From the context menu, select New object > v-RMS (time domain).  

 

 Note: For background information about RMS, see Section 6.2.11 on page 25. 
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The object is displayed in the detailed view.  

 

7. For this object, we will use the vibration sensor at the axial side of the motor as our input. 

Change the name of the object so that it can be clearly identified, and use the Input dropdown 

menu to select the sensor. 
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8. Select the Limits tab. 

 

9. Set the Warning limit to 1.00 mm/s and then the Damage limit to 3.00 mm/s. If you are using 

Imperial units, set the Warning limit to 0.04 in/s and then the Damage limit to 0.12 in/s. 

  

Metric Imperial 

The other object options can be left as default and the parameter can now be written to the diagnostic 
device. 

8.3.3. Observing Object Data 

In this task, you will write the parameter set to the diagnostic device and observe the sensor data.  

1. Save the project. 

2. In the toolbar, click the Write parameter to the device button. 
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3. Ignore the warning message and select Yes.  

 

Note that in the parameter, the object has a green LED next to it. This indicates that the value is 

within limits (has not reached a warning or damage state).  

 

4. In the toolbar, select the Open monitoring window button. 
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The object is displayed in the data monitoring window. There is barely any vibration because the 

motor is off. Note the warning (yellow) and damage (red) zones should be as you defined them 

in the previous task.  

 

 Note: If the object is not visible, select it from the left-side menu.  

 

5. Turn the conveyor on. You should see an increase in vibration on your v-RMS object.  

 

The v-RMS reading should be in the green zone. If it is not, change the warning and damage 

limits so that it is in the green zone. Remember to write the changes to the diagnostic device.    
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6. Take a look at the other monitoring window views. Return to the bar graph view when you 

are done.  

 

7. Stop the conveyor. 

8.3.4. Adding the Rest of the Vibration Sensors 

In this task, you will add new v-RMS objects for the other vibration sensors using the New object wizard. 
The wizard simply presents you with all the options for configuring objects in a specific order, and you 
can configure objects for multiple inputs at the same time.  

1. In the Parameter_01 detailed menu, right-click Objects and, in the context menu, select New 

object wizard.  
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The New object wizard is displayed. The configuration steps are displayed on the left side of the 

window.  

 

2. From the Object type drop-down menu, select v-RMS (time domain) .  

 

3. Click Next.  
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4. For the inputs, select the three sensors that were not used in the previous object and then click 

Next.  

 

5. Give each object an appropriate name and then click Next. 
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6. Keep the default Filtering, Measurement time, and Triggers options settings. Simply click Next 

for each step.  

7. Set all limits to the same limits you set for the existing object: 

▪ Metric – Damage: 3.00 mm/s, Warning: 1.00 mm/s 

▪ Imperial – Damage: 0.12 in/s, Warning: 0.04 in/s 

 Note: Set the Warning limits before setting the Damage limits.  

 

8. Click Finish to confirm the configuration of the objects and to close the wizard.  
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The objects are added to the parameter.  

 

9. Save the project and write the parameter to the diagnostic device. Ignore the warning.  

 

10. Open the monitoring window.  
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11. Only the original object is displayed initially. Ensure that the bar graph view is selected.  

12. Click the left-side panel to open it. 

  

13. Check all objects.  
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The objects are displayed in the bar graph.   

 

14. Turn the conveyor on. The v-RMS reading of all objects should be in the green zone. If they are 

not, adjust the limits until the vibrations are in the green zone and then write the parameter 

changes to the device.  

15. Stop the conveyor.  

16. Save your project. 

17. Exit VES004. 
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9. Lesson 4: Common Machine Faults and 

How to Find Them 

9.1. IN THIS LESSON 

One of the main goals of CBM is to find machine faults as early as possible. In this lesson, we’ll look at 
some common faults and how they can be identified through CBM monitoring. 

9.2. BACKGROUND INFORMATION 

9.2.1. The FFT 

A machine’s vibration signature is made up of individual vibrations. The mathematical algorithm that 
takes a time waveform and extract its frequency components is called the Fast Fourier Transform, or 
FFT. FFT is also another name for the frequency domain view (spectrum).  

How does an FFT work? Consider an orchestra made up of different musicians playing different 
instruments (the blue, purple, and red waves in the image below). The overall sound from the orchestra 
is the sum of all individual instruments (the green waveform). With the proper knowledge, a composer 
can take all of the individual instruments and write each of the notes down on a sheet. This sheet music 
is akin to the frequency domain or FFT. 
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9.2.2. The Importance of the FFT 

The breakdown of individual vibration components in the frequency domain is what allows us to identify 
machine defects.  

For example, a high amplitude at one frequency may point to one type of machine fault, while high 
amplitudes at another frequency may indicate a different type of fault.  

  
One type of machine defect Another type of machine defect 

These differences in vibration frequency measurement and how they can be used to find problems in 
machines is a big part of vibration analysis and CBM in general. 

9.2.3. Common Machine Faults 

9.2.3.1. Overview 

In terms of vibration analysis, machine faults can be broadly categorized into two groups: mechanical 
faults and bearing faults. Mechanical faults are generally detected at low frequencies (10-1000 Hz) and 
their vibration amplitudes are measured as velocities (mm/s or in/s). Bearing faults are detected at 
higher frequencies and their amplitudes are measured as accelerations (m/s2 or mg). 

9.2.4. Mechanical Faults 

Some common mechanical faults include:  

• Unbalance: Unbalance, a type of imbalance, occurs when the center of mass of a rotating 
component, such as a rotor or fan, is not aligned with its axis of rotation. It leads to uneven 
distribution of mass. Unbalance can also be an electrical fault, where the electrical power supply 
isn't distributed evenly among the three phases of the motor.    

• Misalignment: This is the condition where the rotational axes of coupled machine elements, 
such as shafts, are not properly aligned. 

• Looseness: Mechanical looseness is a common fault in machinery that occurs when parts are not 
securely fastened or connected as they should be. 

• Bent Shafts: When a shaft is bent, the components on the shaft no longer rotate around the 
centerline of the system. This causes more mass to rotate around one side of the centerline than 
the other. This is a type of unbalance.  
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• Resonance: This occurs when the natural frequency of the machine foundation is close to or 
equal to the speed frequency. 

• Gearing Defects: These include cracks, breakages, pitting (holes), or wear (erosion) on the gear 
teeth. They also include improper alignment of gears, eccentricity, and backlash. Gearing defects 
will be covered in depth in Lesson 7: Gear Faults on page 119.  

9.2.5. Bearing Faults 

Bearing defects result in increased friction, wear, and noise in the bearing, as well as the presence of 
cracks or pitting in the bearing “races” and rolling elements. They will be discussed in detail in Lesson 8: 
Bearing Faults on page 130. 

9.2.6. Speed Frequency 

For the purposes of analyzing potential machine problems (machine fault analysis), a measure that is 
related to revolutions per minute (RPM) but is even more useful is speed frequency. 

The speed frequency of a motor is the number of times that it rotates per second. Speed frequency is 
measured in Hertz (Hz).  

For example, if a motor runs at 6000 RPM, its speed frequency is 100 Hz. Since there are 60 seconds in a 
minute, we divide the rotational speed by 60 to get the speed frequency: 

6000 RPM / 60 s = 100 Hz  

9.2.7. Identifying Unbalance on the Spectrum 

If there is indeed a problem of unbalance, the spectrum will show one high line. This line will be at the 
speed frequency of the motor.  

We call this frequency 1X (one times the speed frequency). For example, if the motor’s speed frequency 
is 25 Hz, a high peak at 25 Hz on the spectrum would indicate unbalance. If you don’t know the speed 
frequency but you know the rotational speed, multiply the high peak frequency by 60 (for seconds in a 
minute) to get the RPM (e.g., 25 x 60 = 1500 RPM). If the motor’s RPM is 1500, the problem is 
unbalance.  
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9.2.8. Mechanical VS Electrical Unbalance 

How can you tell if unbalance is mechanical or electrical? 

Perform this simple test: Keep your eye on the measured velocity value and switch off the motor.  

• If the vibration velocity value decreases together with the speed decreasing, then the problem is 
mechanical unbalance. 

• If the velocity value immediately drops to almost zero, then the problem is electrical.  
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9.2.9. Identifying Looseness on the Spectrum 

If looseness is the issue, the 1X speed frequency line and its multiples (2X, 3X, 4X, etc.), known as 
harmonics, will have high peaks on the FFT as shown below.  

The amplitudes of the harmonics, and how high these amplitudes are as the frequencies increase, 
depend on the severity of the defect. For example, a high 5X amplitude will only be detectable if there is 
a high degree of mechanical looseness. 

 

If looseness is detected in a machine, it often occurs on one of the machine feet. Measurements taken 
on each of the feet will let you know where the looseness is present – it will be the measurement with 
the highest vibration velocity. A common cause of this type of looseness is damage to one of the anchor 
bolts. 
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9.2.10. Identifying Shaft Misalignment on the Spectrum 

Shaft misalignment can be parallel, angular, or a combination of both. 

9.2.10.1. Parallel Misalignment 

Parallel, or offset, misalignment is when the two shafts are parallel but do not share the same 
centerline. True parallel misalignment is rare, but the spectrum will show high 1X and 2X amplitudes, 
with 2X being higher. A severe defect might also generate high amplitude peaks at higher harmonics (3X 
to 8X). 

 

9.2.10.2. Angular Misalignment 

Angular misalignment is when the center lines of the two shafts meet in the middle of the coupling but 
are not parallel. On the spectrum, you should see a high 1X peak, as well as peaks at the harmonics, 
especially 2X and 3X. 

 

The spectrum of a machine with mechanical looseness might be quite similar to the spectrum of a 
machine with angular misalignment. The main difference between the vibrations of angular 
misalignment and looseness is that high amplitude vibrations of angular misalignment occur in the axial 
direction while high amplitude vibrations of looseness occur in the radial direction. 
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9.2.10.3. Identifying a Bent Shaft on the Spectrum 

Bent shafts are a common source of vibration in many mechanical systems. When a shaft is bent, the 
components on the shaft no longer rotate around the centerline of the system. This causes more mass 
to rotate around one side of the centerline than the other. In short, it’s a type of unbalance.  

The vibrations in both the radial and axial directions will be high. 

• If the bend is near the center of the shaft, 1X will be higher than 2X.  

• If the bend is near the end of the shaft, 2X will be higher than 1X. 

 

9.2.11. Finding Motor RPM and Speed Frequency in Your Lab Setup 

The rotation speed sensor (A) in your CIM system is mounted adjacent to one of the rollers (B) on the 
conveyor. The sensor’s damping magnet (C) is mounted onto the roller by a mounting clip (D). Every 
time that the roller completes a revolution, the magnet passes by the sensor and the sensor registers a 
pulse.  

 

The diagnostic device records the time difference between pulses and calculates the RPM of the 
conveyor roller. This is the Conveyor speed input that we configured in the previous lab activity.  
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Conveyor speed (or RPM), is not the same as motor speed (RPM). This is because the motor (E) runs at a 
high speed, and a gearbox (F) is used to reduce the speed from the motor to the conveyor (G) as well as 
increase the torque.  

 

The reduction ratio of the gear box is 60:1. This means (in a perfect world with no gear slippage or 
energy lost) that the conveyor speed is 1/60th of the speed of the motor. Since our magnetic sensor 
detects the conveyor speed, we need to work in the opposite direction. Therefore, we take the speed of 
the conveyor (roller) and multiply that value by 60 to get the motor speed.  

For example, if the conveyor speed is 30 RPM, the motor speed is 30 RPM x 60 = 1800 RPM.  

That motor speed value is then divided by 60 again to get the speed ratio (There are 60 seconds in a 
minute. See section 9.2.6 above for an explanation of the calculation).    

In the same example, therefore, the motor’s speed frequency would be 30 Hz. 

9.3. REVIEW QUESTIONS 

1. The Fast Fourier Transform (FFT) extracts the ________ from the vibration time waveform.  

a. Amplitude components 

b. Frequency components 

c. Phase components 

d. Time components 
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2. Mechanical machine faults are detected at:  

a. Low frequencies using acceleration measurements. 

b. High frequencies using acceleration measurements. 

c. Low frequencies using velocity measurements. 

d. High frequencies using velocity measurements. 

3. A machine’s motor has a rotational speed of 6000 RPM. Its speed frequency is:  

a. 100 Hz 

b. 600 Hz 

c. 6000 Hz 

d. 120000 Hz 

4. A machine’s motor is running at 1200 RPM. Which of the following is the 2X speed frequency? 

a. 20 Hz 

b. 30 Hz 

c. 35 Hz 

d. 40 Hz 

5. A motor is running at 1800 RPM and there is a single high amplitude peak at 30 Hz on the FFT. 

You switch off the motor and the amplitude value at the peak’s frequency immediately drops to 

0. The machine fault that you have found is: 

a. Mechanical unbalance 

b. Electrical unbalance 

c. Parallel shaft misalignment 

d. Angular shaft misalignment  

6. A motor is running at 2100 RPM and there are high amplitude peaks at 35 Hz, 70 Hz, and 105 Hz 

on the FFT. These velocities are in the machine’s radial direction. The machine fault that you 

have found is: 

a. Bent shaft 

b. Mechanical unbalance 

c. Angular shaft misalignment 

d. Mechanical looseness 
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7. Vibration readings of a machine with a bent shaft will show which of the following on the 

frequency domain view? 

a. High peaks at 1X and 2X.  

b. High peaks at 1X and its harmonics.  

c. A high peak at 1X only.  

d. A high peak at 2X only. 

1:b, 2:c, 3:a, 4:d, 5:b, 6:d, 7:a 

Answers 
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10. Lesson 5: Detecting Machine Faults 

Using Monitoring Software 

10.1. IN THIS LESSON 

10.1.1. Overview 

In this lesson’s lab activity, you will attempt to identify the presence of several machine faults using the 
FFT (frequency spectrum) and several parameter objects.  

10.1.2. Performance Objectives 

After completing this lesson, you will be able to:  

• Identify your machine’s speed frequency. 

• Monitor the machine readings for unbalance and looseness.  

10.2. BACKGROUND INFORMATION 

Recall that the breakdown of individual vibration components in the frequency domain is what allows us 
to identify machine defects.  

For example, a high amplitude at one frequency may point to one type of machine fault, while high 
amplitudes at another frequency may indicate a different type of fault. 

High peaks are found at multiples of the speed frequency. For example, if there is a single peak at 100 
Hz, and 100 Hz is the speed frequency, you probably have a case of unbalance.  

  

A high peak at the 1X speed frequency points to 
unbalance 

High peaks at 1X and 2X the speed frequency with 2X 
being higher probably means that there is a bent shaft.  
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10.3. LAB ACTIVITY 

In this lab activity, you will observe the monitoring software’s frequency spectrum of the various 
acceleration sensors and try to determine if there is a machine fault. You will also create parameter 
objects that will allow you to detect several machine anomalies without having to examine the spectrum 
window.  

Before beginning the lab activity, ensure that your hardware setup is as described in Section 7.3.1 on 
page 35.  

Perform the following procedures: 

10.3.1. Monitoring the Frequency Spectrum 

In this section, you will connect the VES004 monitoring project to the diagnostic device and view aspects 
of the frequency spectrum that could hint to machine faults.  

1. Run VES004.  

2. In the menu bar, select Project > Open. Browse to the project that you created in the previous 

lab activity and open it.  

 Note: The project may also be located in the Recent projects menu.  

3. In the tree view, select the diagnostic device.  

 

4. Ensure that you are connected to the diagnostic device. If you are not connected, connect to it 

now using the Connect to the device option in the toolbar. 
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5. Ensure that the Start project data monitoring button is selected.  

 

6. Open the I/O monitoring window.  

 

7. Observe the motor speed. The conveyor should initially be off (0 RPM).  

 

 Note: If the conveyor speed is not visible, open the left-side menu and select the conveyor speed 

input.  

8. Turn the conveyor on.  

9. Note the speed.  

 

10. Calculate and remember (or record on a notepad) the motor’s speed frequency of your machine. 

In the example above, the speed frequency is approximately 30 Hz. Refer to Section 9.2.6 on 

page 80 and Section 9.2.11 on page 84 for instructions on how to calculate the speed frequency.  

11. Open the spectrum monitoring window.  

 



  

 

91 

  
 

Condition-Based Monitoring |Experiment Guide|Lesson 5: Detecting Machine Faults Using Monitoring Software 

© 2025 Intelitek Inc. All rights reserved | 34-8000-0026_CBM_for_CIM_v1.5.2 

12. Ensure that the spectrum has the following settings, as shown the image below:  

• Resolution: 1.526 Hz 

• Scale: 0 … 1298 Hz 

• Spectrum type: FFT 

• Unit: mm/s 

• Dynamic inputs: Select the sensor on the radial side of the motor perpendicular to the direction 
of the conveyor.  

 

 Note: The axis may be on the left side or the right side of the screen. If the axis is on the right 

side and you prefer it on the left side, right-click the axis and, in the context menu, select Delete 

axis. The input will be deselected. Select the input again in the left panel menu and the 

amplitude axis will be displayed on the left side. 
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13. We want to focus on low frequencies. Zoom in on the low frequencies by clicking, dragging your 

cursor, and creating a red box at the left side of the spectrum as shown. Zoom in further if 

required.  

 

 Note: You can also zoom in by using your mouse’s scroll wheel.  

 Note: To zoom out, right-click an empty area of the graph and select Undo zoom.  

14. Try to observe any high amplitude peaks (3+ mm/s or 0.12+ in/s) at your machine’s speed 

frequency or its multiples (harmonics). For example, a single high peak at the speed frequency 

points to unbalance, while a high peak at both the speed frequency and 2X the speed frequency 

might mean that there is a shaft misalignment. Note that in the image below, the peak 

amplitudes are not high enough to be considered problematic and are thus insignificant.  
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15. Using the left-side menu, select the other acceleration sensors. Check the spectrum for any high 

peaks at the speed frequency or its harmonics.  

 

16. Turn off the conveyor.  

10.3.2. Configuring an Object to Monitor Unbalance 

In this section, you will configure an object that monitors unbalance. Recall that unbalance is 
characterized by a high amplitude peak at the speed frequency. Therefore, this object monitors the 
vibration amplitude at the motor’s speed frequency. The method of using an object helps technicians 
detect faults quickly without having to try to decipher the frequency spectrum.  

Unbalance objects (and other types of objects as well) require triggers, which are essentially reference 
points of various inputs that the object needs in order to decide where to perform the actual 
monitoring. The trigger for this object is motor speed input. 

Perform these steps:  

1. In the tree view, double-click the parameter tab.  
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2. Select the Triggers menu. 

 

3. Right-click an empty area of the detailed view, and in the context menu, select New trigger > 

Analogue input. 
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4. In the detailed view, change the name to something identifiable, such as 

Conveyor_speed_trigger. Leave all other settings as defaults. In the Configuration > Signal 

section, ensure that the Conveyor speed input (IN 1 – the magnetic sensor) is selected.  

 

5. Select the Objects menu.  
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6. Right-click an empty area of the tab and, in the context menu, select New object > Unbalance. 

 

7. The new object is displayed in the detailed view. For this object, we will use the sensor on the 

radial side of the motor that is perpendicular to the direction of the conveyor. Give the object an 

appropriate name and select the relevant input.  
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8. Select the Triggers tab. Ensure that the motor speed trigger is selected.  

9. For Gear ratio, change the Object speed to 60. This is because the reduction ratio of the gear 

box is 60:1.  

 

10. Select the Limits tab. Note the damage and warning limits. These can be changed. However, 

leave them at their default limits of 5 mm/s (0.2 in/s) and 3 mm/s (0.11 in/s).  
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11. Save the project.  

12. Write the parameter to the diagnostic device. Ignore any warnings (click Yes).  

 

13. Return to the spectrum and, from the left side menu, select the motor perpendicular to the 

direction of the conveyor. Note that there is now a blue line at the speed frequency. The motor is 

off currently, so the speed frequency is 0 Hz.  

 



  

 

99 

  
 

Condition-Based Monitoring |Experiment Guide|Lesson 5: Detecting Machine Faults Using Monitoring Software 

© 2025 Intelitek Inc. All rights reserved | 34-8000-0026_CBM_for_CIM_v1.5.2 

14. Turn the conveyor on. Note that the indicator line moves to match the speed frequency (which is 

approximately 30 Hz in our example).  

 

The speed frequency line is key for the unbalance object. The object is simply the vibration amplitude as 
measured by the selected sensor at the speed frequency. 

15. Turn the conveyor off.  

16. Open the (data) monitoring window, which is where you can find the objects you configure.  
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17. Ensure that the bar graph view (at the top left) is selected.  

 

18. Open the left panel menu and check the unbalance object only. Uncheck all other objects.  

 

19. Observe the unbalance object, which should be 0. Note the motor speed is displayed on the 

right, as is the actual vibration amplitude value at the 1X speed frequency.  

 

20. Turn the conveyor on. The motor speed should increase. The vibration velocity amplitude may 

increase but should be within limits (It still 0.077 mm/s in the image below). If it is not within 

limits, there may be an unbalance fault in your machine! You should consult with your instructor 

or system manager if this is the case.   
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21. Turn off the conveyor.  

22. Create unbalance objects for the other sensors. Don’t forget to: 

▪ Change the inputs (sensors) when creating the object.   

▪ Change the gear ratios.  

▪ Write the parameter to the diagnostic device.  

▪ Turn the conveyor on to test the objects.  

▪ Ensure that the objects are selected in the left side panel.  

▪ Observe the different objects and compare them. 

▪ Observe the different spectra and compare them. To switch to a different sensor’s spectrum, 

select it in the left side panel.  

 Pro tip! Use the New object wizard to configure your unbalance objects quickly and easily.  

23. Turn the conveyor off when you are done.  

10.3.3. Configuring Objects to Monitor for Looseness 

In this task, you will create an object in your parameter set that monitors mechanical looseness. Recall 
from Section 9.2.9  (on page 82) that on the spectrum, looseness is characterized by high vibration 
amplitude peaks at the 1X speed frequency and its harmonics.  

1. Return to the parameter and open the Objects menu. 
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2. Right-click an empty space in the Objects menu, and in the context menu, select New object > 

Others.  

 

3. The object opens in the detailed view. Use any one of the four vibration sensors for the input. 

Name the object appropriately.  
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4. Select the Subobjects tab. The subobjects represent the frequency to be monitored. By default, 

only the 1X speed frequency is included (Frequency factor 1.000). In the next several steps, you 

will add more subobjects to account for the harmonics (2X, 3X, etc.).  

 

5. Select the subobject.  

 

6. Click the Modify the selected subobject button.  
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7. Change the subobject’s name to Looseness_1X or another appropriate name, and then click 

Finish.  

 

The name is changed in the subobject list.  

8. Click the + button.  
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9. The Configure subobject dialog is displayed. Change the Name to Looseness_2X or similar and 

change the Frequency factor to 2. Click Finish.  

 

The new subobject is displayed in the list.  
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10. Configure additional subobjects for the 3X, 4X, 5X, and 6X speed frequencies.  

 

11. Select the object’s Processing tab and change the Engineering unit to the Velocity unit.  
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12. Change the Resolution to 1.526 Hz using the dropdown list.  

 

13. Select the object’s Triggers tab. Ensure that the trigger is the speed trigger. Change the Gear 

ratio’s Object speed to 60. 
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14. Select the Limits tab. Change the Damage limit to 5.00 mm/s (0.20 in/s) and the Warning limit 

to 3.00 mm/s (0.11 in/s). 

 

15. The object is now configured to monitor for mechanical looseness. Save the project and then 

write the parameter to the diagnostic device. Ignore the warnings (select Yes when prompted).  

 

16. Turn the conveyor on.  

17. Open the spectrum monitoring window.  
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18. Select the input for which you configured the object.  

 

19. Observe the spectrum. Adjust the zoom until you can see all the indicators.  

Note how there are now indicators at the 2X-6X speed frequency harmonics. Is there any 

significant vibration at these frequencies in your system? Do you detect mechanical looseness? 
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 Note: The unbalance object indicator is still present at 1X, but it might be covered by the 1X 

looseness indicator. The legend at the bottom of the spectrum lets you know which objects are 

being used on the selected input.  

 

20. Open the monitoring window.  

 

21. In the left-side menu, select the new looseness object. Deselect all other objects. Observe the 

object in the bar graph view. It should be within limits.    

 

The object adds the total of all of the amplitudes at the subobject frequencies.  
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22. Configure looseness objects for the other three acceleration sensors and write them to the 

diagnostic device. Compare the objects in the data monitoring window.  

 

 Note: The New object wizard cannot be used for this purpose. However, you can copy/paste an 

object and then make modifications. Right-click the object and select Copy, then right click an 

empty area of the Objects menu and select Paste. Rename the object and modify the input.  

  

23. Turn off the conveyor.  
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11. Lesson 6: Filters 

11.1. IN THIS LESSON 

11.1.1. Overview 

There are several analysis tools that can help us clearly see the data in the frequency spectrum, which 
can help us find machine defects more quickly. In this lesson, we’ll look at what some of these tools are. 

11.1.2. Performance Objectives 

After completing this lesson, you will be able to:  

• Identify and apply filters and related functions in the monitoring software. 

11.2. BACKGROUND INFORMATION 

11.2.1. Bins and Resolution 

In an FFT (Fast Fourier Transform), the frequency range of interest is divided into discrete lines or bins. 
Each bin represents a specific frequency range or band.  

The resolution of the frequency spectrum depends on the number of bins used and the frequency range 
you want to analyze. 
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11.2.2. Frequency Ranges of Interest 

As previously discussed, different types of machine faults require analysis of different frequency 
ranges. For example, to check for unbalance, we only need to look at low frequency ranges on an FFT.  

Vibrations still may occur at high frequencies, but we are not interested in those frequencies. 

 

11.2.3. Filters 

Filters can help us focus on a frequency range of interest. They do so by removing unwanted frequency 
ranges such as in the example below. 

  

No filter Filter applied 



  

 

114 

  
 

Condition-Based Monitoring |Experiment Guide|Lesson 6: Filters 

© 2025 Intelitek Inc. All rights reserved | 34-8000-0026_CBM_for_CIM_v1.5.2 

 

11.2.4. Filters on the Time Waveform 

Besides the FFT, filters can be applied to the time waveform. Click or scan the QR code below an 
example of a filter being applied. Observe what happens to the waveform.   

 

11.2.5. Types of Filters 

In vibration analysis, there are four main types of filters: 

• Low-pass filters pass (allow) frequencies below a specified limit. For example, a low-pass filter of 
1000 Hz would allow you to see frequencies from 0 to 1000 Hz. 

• High-pass filters pass frequencies above a specified limit. For example, a high-pass filter of 1000 
Hz would allow you to see all frequencies above 1000 Hz. 

• Band-pass filters pass frequencies within a specified range. For example, a band-pass filter of 
400…1200 Hz would only allow you to see frequencies in that range. 

• Band-stop filters, also known as notch filters, block (filter out) frequencies within a specified 
range. For example, a band-stop filter of 400…1200 Hz would only allow you to see frequencies 
below 400 Hz and above 1200 Hz. These types of filters are used mainly to block out specific 
frequencies that are interfering with analysis. 

11.2.6. Other Filter Applications 

We’ve seen that low pass filters can be used to focus on mechanical fault frequencies, but there are 
other applications for filters as well. 

11.2.6.1. Anti-Aliasing 

One such application is during signal conversion. Signals from vibration sensors are in analog form. In 
order to work with analyzers and diagnostic devices, the signal must be converted to digital form. This 
conversion is done by an A/D converter.  

If the original signal contains frequencies higher than half the sampling frequency, the signal will be 
distorted by the phenomenon known as aliasing. To prevent aliasing, these higher frequencies are 
filtered out by a low pass filter so that they do not enter the converter. These high frequencies are 
missing in the digital signal, but we have prevented the creation of new, unrealistic frequencies. 

https://tinyurl.com/24kp7ngd
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11.2.6.2. Signal Demodulation for Bearing Analysis 

Another use of filters is for bearing fault analysis. Here is a brief summary of how it works:  

Bearing fault frequencies do not appear on a normal frequency domain. To determine the frequency of 
a fault, signal demodulation is used. This involves applying a high-pass filter which removes all 
frequencies below a certain level.  

Energy is artificially added to the signal using envelope detection, another signal processing technique. 
The signal is then processed through FFT to create a spectrum from which a vibration analyst can 
determine the fault frequency. This is presented in the monitoring software as H-FFT. 

We will learn about bearing faults in greater depth in Section 13. 

11.2.7. Averaging  

11.2.7.1. Vibration Variation – The Need for Averaging 

In machines, vibration changes constantly due to factors like gear meshing and bearing movement. This 
creates noise, making it challenging to get a clear vibration reading. Therefore, a method to capture an 
accurate representation of the machine's vibration is required. 

11.2.7.2. The Role of Averaging 

Averaging helps create a stable and repeatable measurement of vibration. It smooths out variations 
caused by noise and ensures consistency in readings. Without averaging, slight changes in vibration 
might lead to misleading conclusions about the machine's condition.  

The goal of averaging is to obtain repeatable measurements. If the machine's condition hasn't changed, 
the vibration readings should remain consistent over time. Averaging helps ensure that any variation in 
readings is due to actual changes in machine condition, not noise. 

11.2.8. The Averaging Process 

How does averaging work? This is a summary of the process: 

1. The diagnostic device captures a time record of the vibration data (time waveform). 

2. The device then grabs a chunk of the data. The size of the chunk taken depends on the 

resolution and the fmax (the maximum frequency that can be measured by the diagnostic device). 

3. The chunk of waveform must then undergo a process known as windowing, which tapers the 

ends of the chunk of waveform. Without this windowing, there is leakage in the FFT – a 

phenomenon where the amplitude peaks spread out over large numbers of frequencies. 

4. The diagnostic device takes the window and calculates the FFT. If this FFT alone were to be 

considered, there would definitely be variation between it and the next vibration measurement. 

Therefore, the diagnostic device grabs another block of time, windows that, and creates another 

FFT. 

5. It repeats doing this several times and takes the average amplitude values of each frequency bin 

of those FFTs, in addition to the noise areas at the bottom. 

The average spectrum represents a smoother, more stable version of the machine's vibration, with the 
noise minimized. This allows analysts to focus on significant vibration patterns. By reducing noise and 
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providing stable measurements, averaging allows for more accurate diagnosis and predictive 
maintenance.  

The type of averaging that we covered above is called linear averaging, but there are other types of 
averaging too. 

11.2.9. The Number of Averages 

In the monitoring software, you may have seen options for averaging represented by fractions.  

The fractions represent the number of averages taken per measurement. For example, "1/2" means that 
two measurements are averaged together, "1/4" means four measurements are averaged, and so on.  

The larger the denominator, the more averages are taken, leading to smoother data but requiring more 
time for each measurement. 
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11.3. REVIEW QUESTIONS 

1. Which of the following statements about filters in vibration analysis is/are true? 

a. They remove specified ranges of frequencies.  

b. They add specified ranges of frequencies. 

c. They help focus on frequency ranges of interest.  

d. They can be applied to the time waveform.  

2. A 400 Hz low pass filter: 

a. Blocks frequencies lower than 400 Hz.  

b. Allows frequencies lower than 400 Hz. 

c. Only allows you to see amplitudes of 400 Hz.  

3. On an FFT, you only want to see bins between 30 and 500 Hz. Which of the following filters 

should you apply? 

a. Low pass 500 Hz 

b. High pass 30 Hz 

c. Band pass 30…500 Hz 

d. Band stop 30…500 Hz 

4. Notch filters: 

a. Pass frequencies within a specific range.  

b. Block frequencies within a specific range. 

5. An 800 Hz peak would be present on a frequency domain when using a 1000 Hz high pass filter.  

a. True 

b. False 

6. Windowing is used to: 

a. Calculate a good FFT without leakage. 

b. Determine the amount of averaging used.  

c. Filter out specified bands of frequencies.  
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7. The goal of averaging is to: 

a. Obtain repeatable measurements and reduce variation.  

b. Remove specified bands of frequencies. 

c. Prevent aliasing. 
1:a,c&d 2:b, 3:c, 4:b, 5:b, 6:a, 7:a 

Answers 
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12. Lesson 7: Gear Faults 

12.1. IN THIS LESSON 

12.1.1. Overview 

This lesson provides an overview of common machine faults and anomalies related to gearboxes which 
can be monitored and preempted using vibration analysis and CBM. 

12.1.2. Performance Objectives 

After completing the lesson, you will be able to list common gearbox faults and how to identify them 
using condition-based monitoring.  

12.2. BACKGROUND INFORMATION 

12.2.1. What is a Gearbox? 

A gearbox changes the speed or torque (rotational force) of an input source, like a motor, into a 
different speed or torque output. Gearboxes are commonly used in industrial machinery to match the 
speed and power requirements of different parts of a machine or process. For example, they can slow 
down the fast rotation of a motor to provide more torque for heavy lifting.  

 

Cross-section of a gearbox 
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12.2.2. Overview of Gearbox Faults 

Faults in a gearbox cause normal, low-frequency harmonics on the vibration spectrum. However, they 
also show a lot of activity in the high-frequency regions due to gear teeth (and bearing) impacts. 

Typical gearing defects include: 

• Cracks, breakages, pitting (holes), or wear (erosion) on the gear teeth.  

• Improper alignment of gears. This also leads to uneven wear in the gear teeth. 

• Gear eccentricity, which is a type of imbalance or non-uniformity in gear rotation.  

• Excessive backlash (usually just called “backlash”) where there is too much clearance between 
the mating teeth of two gears. 

All these defects lead to an increase in vibration. 

 

A damaged gear tooth 
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12.2.3. Understanding Gearing Defects: Gear Mesh Frequency 

Like the other faults that we’ve already learned about, it is helpful to know the motor’s speed frequency 
to determine if there is a gearing defect in your machine.  

However, there is an additional frequency that can help us specifically detect gearing faults, and that is 
the gear mesh frequency (GMF).  

The GMF of a gear (or pinion) is the product of the number of teeth on the gear and its rotational speed 
in RPM. 

 

GMF = number of teeth on gear x gear RPM 

12.2.4. Gearing Defects on the Spectrum 

12.2.4.1. Overview 

The spectrum of a gearbox in good condition will have several low peaks, including at the various GMFs 
of the different gears in the box.  

If a gear has defects, the amplitudes of these peaks will increase, and sidebands will appear at either 
side of the gear’s GMF (and potentially the GMF harmonics).  

Sidebands are additional peaks of vibration energy that appear on either side of a main frequency 
peak. 

Vibrations of spur gears are detected in the radial direction (of the gear), while vibrations of helical gears 
are detected in the axial direction (of the gear). 
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12.2.4.2. Gear Misalignment 

When gears are misaligned, their GMF harmonics are excited (those vibration frequencies increase). The 
2X GMF or 3X GMF and their sidebands will be higher than the 1X GMF and its sidebands, as in the 
spectrum below. 

 

12.2.4.3. Cracked Tooth 

A cracked or broken gear tooth will generate a high amplitude peak at 1X RPM of its own running 
speed and its GMF with sidebands will also be seen. However, this type of defect is best detected in the 
time domain, which will show a pronounced spike every time the problematic tooth tries to mesh with 
teeth on the mating gear. 
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12.2.4.4. Gear Wear 

A tell-tale characteristic of gear tooth wear is if the gear's natural frequencies (i.e., resonant 
frequencies) are excited with sidebands around them. The GMF may or may not change in amplitude, 
although high-amplitude sidebands surrounding the GMF usually occur when wear is present. 

 

12.2.4.5. Backlash and Eccentricity 

In gears with excessive backlash or eccentricity, there will be a relatively high peak at the GMF with high 
amplitude sidebands. The natural frequencies may also be excited, although not at the amplitude of 
gears with excessive wear. 
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12.3. LAB ACTIVITY 

In this lab activity, you will perform basic vibration analysis on the gear box. You will also get a chance to 
experiment with filters and averaging.  

Perform the procedures below.  

 Note: This lab activity requires access to the conveyor motor. If you cannot access the motor, skip 

to the section Review Questions on page 129. 

12.3.1. Hardware Setup 

Remove the acceleration sensor from the motor assembly panel and mount it on the side of the gear 
box as shown.  

  

All other components should be as described in Section 7.3.1 on page 35. 

12.3.2. Viewing the Spectrum 

In this section, you will use the frequency spectrum to attempt to observe if your system’s gear box can 
be given a full bill of health.  

1. Run VES004.  

2. In the menu bar, select Project > Open. Browse to the project that you created in the previous 

lab activity and open it.  

 Note: The project may also be located in the Recent projects menu.  
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3. In the project tree, select the diagnostic device.  

 

4. Ensure that you are connected to the diagnostic device. If you are not connected, connect to it 

now. 

  

5. Ensure that the Start project data monitoring button is selected.  
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6. Double-click the parameter to open it in the detailed view.  

  

7. Select the Inputs menu.  

 

8. Select the input that refers to the sensor on the front of the motor assembly panel.  
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9. In the detailed view, change the input’s name to Gearbox or similar.  

 

10. Save the project, and then write the parameter to the device. Ignore the warnings.  

 

11. Open the spectrum window.  

 

12. In the left-side panel, select the Gearbox input.  

 

13. In the legend below the spectrum, deselect the two objects.  
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14. Your gear box drive is made up of two drive components, a worm and a worm gear. Calculate the 

GMF of both components.  

▪ The worm has 1 “start” (equivalent of a gear tooth). Its GMF is equal to the conveyor 

speed RPM in Hertz (in our example, 30 Hz). 

▪ The gear has 60 teeth and is driven directly by the motor. To calculate the GMF of this gear, 

multiple the motor speed frequency by 60 (in our example, 30 Hz x 60 = 1800 Hz). Turn the 

conveyor on.  

15. Observe the spectrum at the GMF frequencies of the two components. Are there any peaks or 

sidebands? Take a look at the 2X GMF and the 3X GMF as well. Is your gearbox healthy, or does it 

need maintenance?  

16. Stop the conveyor.  

17. Take the acceleration sensor off the gearbox and mount it back onto the front panel of the 

motor assembly.  

 

18. Rename the input to refer to the current location of the sensor.  

 

19. Save the project. 

20. Write the parameter to the diagnostic device. Ignore the warnings.  

21. Exit VES004.  
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12.4. REVIEW QUESTIONS 

1. A gear with 10 teeth rotates at 1000 RPM. What is its gear mesh frequency in RPM? 

a. 1000 

b. 6000 

c. 10,000 

d. 60,000 

2. If a gear with 30 teeth rotates at 500 RPM, its gear mesh frequency (GMF) in RPM is: 

a. 500 RPM 

b. 530 RPM 

c. 1000 RPM 

d. 15000 RPM 

3. A gear with 10 teeth rotates at 2400 RPM. The gear has a cracked tooth. At what frequency, in 

Hz, would you expect to see a high amplitude peak with sidebands? 

a. 240 

b. 400 

c. 2400 

d. 24,000 

4. Which of the following gear defects can be identified by high amplitude GMF harmonics and 

their sidebands? 

a. Eccentricity 

b. Wear 

c. Misalignment 

d. A damaged tooth 

1:c, 2:d, 3:b, 4:c 

Answers 
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13. Lesson 8: Bearing Faults 

13.1. IN THIS LESSON 

13.1.1. Overview 

Bearing vibration analysis is a science of its own, and the identification of bearing faults is complex and 
multi-faceted. In this lesson, we will try to provide a basic explanation of this type of analysis and its 
main concepts. 

13.1.2. Performance Objectives 

After completing this lesson, you will be able to:  

• Identify the parts of a bearing. 

• List different faults related to bearings.  

• Identify different types of bearing faults on a frequency spectrum.  

13.2. BACKGROUND INFORMATION 

13.2.1. What are Bearings? 

Before delving into the type of faults that can be found in bearings, it is important to understand what a 
bearing is and what its component parts are.  

13.2.2. Types of Bearings 

There are two main types of bearings:  

• Plain bearings, also known as slide bearings, have two surfaces that slide relative to one 
another. 

• Rolling element bearings, also called anti-friction bearings, have balls or rollers that rotate 
freely. These bearings are also called ball-bearings or roller-bearings. They will be our focus in 
this lesson. 
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13.2.3. Rolling Element Bearing Components 

Anti-friction (rolling element) bearings operate on the principle of rolling motion. The rolling action in 
anti-friction bearings produces less friction than the sliding motion in plain bearings. However, some 
friction still occurs between the rolling and non-rolling components. These bearings must be kept 
lubricated to reduce this sliding friction. 

The bearings contain either rollers or balls mounted in circular frames called raceways. A separator or 
cage is used to evenly space the balls or rollers around the diameter of the bearing. 

 

13.2.4. Bearing Defects in Rolling Element Bearings 

We’ve seen that an anti-friction bearing has four main components: the outer race, the inner race, the 
rolling elements, and the cage. Each of these components can develop defects. For example:  

• Cracking, pitting, or spalling (peeling) to the outer race or to the inner race. 

• Spalling, cracking, or brinelling (the appearance of indentations) to the rolling elements. 

• Cage damage. 

In addition, defects can arise from inadequate or faulty lubrication of the bearing. 
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13.2.5. Bearing Fault Tones 

When a bearing defect, such as spalling or brinelling occurs, it can generate vibrations that produce an 
audible tone, which may sound like a whine or rumble. 

This tone, known as bearing fault tone, is a vibration that can be detected by acceleration sensors.  

An example of a defect that causes a bearing tone is pitting on the outer race. 

 

Click or scan the QR to watch an animation of the generation of a bearing tone. 

https://tinyurl.com/24fxdp8b
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13.2.6. Understanding Bearing Tones 

There are three different methods for understanding bearing tones: 

• On the time waveform, where the impacts are visible. By measuring the time between impacts, 
you can calculate the frequency of the bearing tone. 

 

Impacts visible on the time waveform. From Jain & Bhosle, 2021. 

• On the spectrum, where peaks of the bearing tone frequency and its harmonics can be seen.  

 

Typical frequency spectrum of a bearing with an outer race defect. From Jain & Bhosle, 2021. 

• Using signal demodulation, which filters out low-frequency vibrations to isolate the high-
frequency sound of the bearing tone. By analyzing the frequency of this sound using filters, 
technicians can determine the rate of occurrence of the bearing tone, providing another 
perspective on the defect. 
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13.2.7. Bearing Fault Frequencies 

With more information about a bearing, we can more accurately determine where a defect is coming 
from. To do this, knowledge of the bearing fault frequencies is necessary. 

A bearing fault frequency is a unique vibration frequency generated by defects in each of the 
components of the bearing.  

Manufacturers typically provide four frequencies:  

• BPFI: Ball pass frequency inner race, the frequency at which the rolling elements in a bearing 
pass over a fixed location on the inner race.  

• BPFO: Ball pass frequency outer race, the frequency at which the rolling elements in a bearing 
pass over a fixed location on the outer race. 

• BSF: Ball spin frequency (for the rolling element), the frequency at which the rolling elements 
spin within their raceways. 

• FTF: Fundamental train frequency (for the cage), the frequency at which the cage rotates around 
its axis.  

These frequencies represent the number of times a specific point on a bearing component interacts with 
a rolling element or cage assembly per shaft rotation.  

Note that a bearing fault frequency is not the same as a bearing tone frequency. 

13.2.8. Bearing Analysis on the Spectrum 

We will conclude our discussion of bearing fault analysis with a look at the FFT spectrum for bearing 
defects. 

Zones of the Spectrum 

In order to understand the FFT when it comes to bearing analysis, technicians divide the spectrum into 
four zones, labeled A, B, C, and D. 

 

• Zone A is the machine RPM and harmonics zone. It is not relevant for bearing analysis. 

• Zone B is the bearing fault frequencies zone. Its range is about 80 to 500 Hz. 

• Zone C ranges from 500 Hz to 2 kHz (2000 Hz) and it is the zone with the bearing’s natural 
(resonant) frequencies. Like in Zone B, high amplitude peaks in Zone C will have sidebands. 

• Zone D is also called the high-frequency-defection (HFD) zone. It contains detectable 
frequencies above 2 kHz. 
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A Healthy Bearing 

The earlier a bearing defect can be found, the better. This is why engineers also divide up the 
development of bearing defects into stages. In a new, healthy bearing, there will be no indications of 
damage, wear, or defects. 

 

Stage 1 

The first indications of bearing wear show up in ultrasonic frequency ranges on Zone D – from 20 to 60 
kHz. They are only detectable using high-frequency detection techniques. Lubricating the bearing at a 
planned downtime may be the best option here. 

 

Stage 2 

The bearings raceways begin to develop tiny pitting at this stage. High-frequency peaks are more 
common and increase in amplitude. There may also be low amplitude peaks in Zone C. At this point, it is 
time to think about replacing the bearing. 
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Stage 3 

The pitting become larger at this stage and the peaks and sidebands of Zone C are clearly visible. Bearing 
defect frequencies can be seen as well. The bearing should be replaced before a major machine 
breakdown happens. 

 

Stage 4 

In the final stage, the bearing is severely damaged. The pitting merge with each other, creating rough 
tracks and spalling of the raceways and/or rolling elements. Bearing frequencies that were once discrete 
begin to merge into a random “noise floor”. 

 

13.3. REVIEW QUESTIONS 

1. “Spalling” on a bearing race means that: 

a. The component is peeling. 

b. The component is developing small holes.  

c. The component is cracking.  

d. Indentations are beginning to appear on the component. 
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2. Which of the following statements about a bearing tone caused by a defect is/are true? 

a. Impacts from a bearing tone can be seen on a time waveform.  

b. The frequency of the tone itself can be analyzed using signal demodulation.  

c. Peaks of the bearing tone frequency and its harmonics may be visible on the FFT spectrum.  

d. BFPO and BPFI are examples of bearing tone frequencies.   

3. BFPI is (select all correct answers): 

a. The frequency at which the rolling elements in a bearing pass over a fixed location on the 

outer race. 

b. The frequency at which the rolling elements in bearing a pass over a fixed location on the 

inner race. 

c. A bearing fault frequency that is usually provided by manufacturers of a bearing.  

d. A bearing tone frequency.  

4. Which of the following statements best describes a healthy bearing? 

a. Vibration peaks will not be seen in Zones B, C, and D.  

b. Vibration peaks will not be seen in Zones B and C. 

c. Low vibrations peaks will be seen in all zones.  

d. Zone A has low amplitude peaks which represent natural bearing frequencies.   

5. Which of the following is/are true about a bearing that needs replacement but is not completely 

damaged yet? 

a. Vibration peaks will not be seen in Zones B and C. 

b. Peaks and sidebands of bearing fault frequencies are visible.  

c. Peaks and sidebands of bearing natural frequencies are visible.  

d. High-frequency peaks are visible. 

Answers 

1:a, 2:a,b&c, 3:b&c, 4:a, 5:b,c&d 
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14. Lesson 9: Implementing CBM 

14.1. IN THIS LESSON 

14.1.1. Overview 

In this lesson’s lab activity, we will use the monitoring software to create a project which will oversee 
the long-term health of your machine using historical trends, objects, counters, and alarms. 

14.1.2. Performance Objectives 

After completing this lesson, you will be able to: 

• Configure limit monitors. 

• Configure an alarm.  

• Configure a counter. 

• Analyze machine history. 

14.2. BACKGROUND INFORMATION 

14.2.1. Maintenance-Related KPIs 

In order to understand how condition-based monitoring can help companies get the best out of their 
machines, they use key performance indicators (KPIs). KPIs are metrics that companies use to measure 
success. Here are some important ones:  

14.2.1.1. OEE 

Overall Equipment Effectiveness (OEE) measures how effectively a machine is employed by combining 
three metrics: availability, performance efficiency, and quality. OEE should be as high as possible. 

OEE = Availability × Performance Efficiency × Quality Rate 

• Availability is the ratio of the actual runtime to the planned production time.  

Availability = (Actual Runtime / Planned Production Time) × 100 

• Performance efficiency measures how well a machine performs at maximum speed.  

Performance Efficiency = (Actual Production Rate / Maximum Possible Production Rate) × 100 

• Quality rate is the ratio of good-quality products to the total number of products produced.  

Quality Rate = (Number of Good Products / Total Number of Products) × 100 

For example, if a machine is available 90% of the time, operates at 80% of its maximum speed, and 
produces 95% quality products, the OEE is 68.4%. 
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14.2.1.2. MTTR 

Mean Time To Repair (MTTR) is the average time it takes to repair a failed machine and restore it to 
normal operation. MTTR should be as low as possible. 

MTTR = Total Downtime / Number of Breakdowns 

To calculate MTTR:   

• Identify the total downtime: Add up the time the machine was out of service due to various 
failures. 

• Count the number of breakdowns: Determine how many times the machine failed. 

• Divide the total downtime by the number of breakdowns. 

For example, if a machine is down for a total of 5 hours due to three breakdowns, the MTTR is 5 hours / 
3 breakdowns = 1.67 hours per breakdown. 

14.2.1.3. MTBF 

Mean Time Between Failures (MTBF) is the average time a machine operates between one failure and 
the next. MTBF should be as high as possible. 

MTBF = Total Uptime / Number of breakdowns 

For example, if a machine operates for 100 hours before the first failure and 120 hours before the 
second failure, the MTBF is (100 hours + 120 hours) / 2 failures = 110 hours. 

The formula for MTBF is nearly identical to that of MTTR. However, total downtime is replaced by total 
uptime. Uptime is the time that the machine is available or running (it is the opposite of downtime).   

 Important note: There is a difference between uptime and runtime. Uptime is the time that the 

machine is available or running, while runtime refers to when the machine is actively performing 

tasks. 
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14.2.2. Measuring the Influence of CBM 

The KPIs in the previous section can be used to understand the influence of condition-based monitoring.  

Consider the graph representing the life of a machine or machine component.  

The X-axis is the machine’s time in operation. The more the machine is used, the farther to the right you 
will be on the axis.  

The Y-axis is the machine’s life consumption. The higher the location on the axis, the closer the machine 
or component is to failure. 

  

This graph was modified from the one originally published in 

Economic and Safety Benefits of Diagnostics and Prognostics (Romero et al, 1996). 

Scan or click me to watch 
an explanatory video! 

https://youtu.be/X6z6xcmtCTM
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14.2.3. Using the Objects in the Monitoring Software 

Let’s now turn our attention back to the CBM monitoring software.  

Previously, we used software “objects” to look for specific faults, such as unbalance and looseness.  

Once our objects are configured, they can be linked to counters and alarms that will alert us if there are 
any concerns for our machine. 

 

Objects in the VES004 object monitoring window 
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14.2.4. Historical Trends 

Even if a machine is healthy and there are no apparent defects, understanding historical trends can help 
us identify if, and when, a defect is likely to occur.  

For example, consider a v-RMS object where you defined the warning limit as 4 mm/s (0.16 in/s). In both 
graphs below, the measured vibration is well within limits, but we can see that the graph on the right is 
rising. If the trend continues, the vibrations will reach warning limits within a couple weeks. We can then 
try to discover the problem and schedule maintenance during a planned downtime if necessary. 

Stable Trend Unstable (Rising) Trend 

  

14.2.5. Trends and Patterns 

Trends don’t have to be related to vibration analysis to be useful. Consider the monitoring of motor 
speed data. Say that after several months of use, a motor that is supposed to run at 2000 RPM slowly 
lowers its speed over that time to 1970 RPM, even though it is driven by the same AC frequency. This 
type of trend may point to a problem with the motor that can be identified and fixed when convenient.  

14.2.6. Trends, Counters, and Alarms 

We can make use of both trends, counters, and alarms in our monitoring setup.  

As we saw above, trends can give us long-term forecasts. Counters and alarms can help us in the short 
term.  

How are counters and alarms used together? If an object is in the warning or damage range for several 
seconds, this may not mean anything in terms of machine health. It could be an anomaly in the electrical 
power input that heats the motor or a passing truck that increases vibrations. However, an object going 
beyond limits for several minutes or hours, as measured by a counter, can trigger an alarm that alerts 
technicians immediately. 
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14.3. LAB ACTIVITY 

In the previous lab activities, you used the monitoring software to help identify specific machine defects. 
Condition-based monitoring (CBM), though, is more than just finding faults in an industrial machine.  

In this lab activity, you will employ the monitoring software as it was intended – to create a project that 
will oversee the long-term health of your machine using historical trends, objects, and alarms. 

Perform the following procedures:  

14.3.1. Creating an Upper Limit Monitor 

In this task, you will create an upper limit monitor to keep track of motor temperature and ensure that it 
does not exceed a specified threshold.    

1. Run VES004.  

2. In the menu bar, select Project > Open. Browse to the project that you created in the previous 

lab activity and open it.  

 Note: The project may also be located in the Recent projects menu.  

3. In the project tree, select the diagnostic device.  

 

4. Ensure that you are connected to the diagnostic device. If you are not connected, connect to it 

now. 
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5. Ensure that the Start project data monitoring button is selected.  

 

6. Double-click the parameter to open it in the detailed view.  

  

7. Select the Objects menu.  
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8. Right-click an empty space in the Objects menu and, in the context menu, select New object > 

Upper limit monitor.  

 

9. The object is displayed in the Detailed view. In the Configuration tab: 

a. Change the name of the object to Temperature_Upper_Limit or similar.  

b. Change the input to the Temperature sensor.  
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10. Change the Damage limit to 10 degrees C (20 degrees F) above the normal running temperature 

and the Warning limit to 5 degrees C (10 degrees F) above the normal temperature. Our limits of 

40 C (105 F) and 35 C (95 F) are shown below.  

 

11. Save the project.  

12. Write the parameter to the device. Ignore the warnings.  

 

13. Opening the data monitoring window.  

 

14. In the left-side menu, select the new object and deselect all others.  
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15. Observe the object in bar graph view. It should be within limits. 

 

16. Turn the conveyor on. Let it run as you perform the next task.  

14.3.2. Creating a Lower Limit Monitor 

In this task, you will configure a lower-limit monitor for conveyor speed to ensure that the conveyor 
does not drop below a designated speed.  

1. Return to the Parameter tab.  

 

2. Right-click an empty space in the Objects menu and select New object > Lower Limit Monitor.  
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3. The object is displayed in the detailed view. Give the object an appropriate name such as 

Conveyor_Speed_Lower_Limit. For the input, ensure that the Conveyor speed input is selected.  

 

4. Set the Warning limit to 5 RPM below the normal running speed and the Damage limit to 10 

RPM below the normal running speed. Our limits are shown below.  

 

5. Write the parameter to the device. Ignore the warnings.  

 



  

 

149 

  
 

Condition-Based Monitoring |Experiment Guide|Lesson 9: Implementing CBM 

© 2025 Intelitek Inc. All rights reserved | 34-8000-0026_CBM_for_CIM_v1.5.2 

6. Opening the data monitoring window.  

 

7. In the left-side menu, select the new object and deselect all others.  

 

8. Observe the object in bar graph view. It should be within limits. 

 

9. Turn the conveyor off. Observe that the object is no longer within limits.  
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14.3.3. Creating an Alarm 

In this task you will configure an alarm. When the criteria for the alarm are fulfilled, a signal is sent to an 
output, usually in the form of an output signal to a programmable logic controller (PLC) or human-
machine interface (HMI). For the purposes of this lab activity, however, the output will be one of the 
virtual outputs in the I/O monitoring window. If the virtual output is Lo, that means that the alarm is off. 
If it is Hi, that means that the alarm is on. 

1. Turn the conveyor on.  

2. Return to the Parameter tab.  

3. Select the Alarms menu.  

 

4. Right-click an empty area of the menu and select New alarm > Custom.  
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5. In the Configuration tab, leave the name as is. It can be changed later if desired. Change the 

Output to Virtual Output 1.  

 

6. Lower down in the same tab, in the Configuration section, in the Switch dropdown list, select 

Normally open.  
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7. In the Source tab, select Warning (OR) for the Conveyor_Speed_Lower_Limit.  

 

This logic condition means that the alarm will turn on (Hi) if the conveyor speed lower limit 

reaches either the warning limit OR the damage limit.   

8. Save the project.  

9. Write the parameter to the diagnostic device. Ignore the warning(s).  

 

10. Open the I/O monitoring window.  
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11. In the left-side menu, select the two inputs and Virtual Output 1. Deselect the other outputs.   

  

12. Observe the I/O list in table view.  

Our Conveyor speed input is above the lower limits, so the alarm we configured is off. The 

Virtual Output 1 value reflects this: It is Lo.   

 

13. Turn off the conveyor.  

Conveyor speed is now below the lower limit, so the alarm turns off. This is reflected in the value 

of Virtual Output 2, which is now Hi.  
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14.3.4. Configuring a Counter 

Counters are used to keep track of how long an event has been occurring. In this task, you will create a 
counter to keep track of how long the conveyor has been running for.   

1. Select the Parameter tab.  

 

2. Select the Triggers tab.  

 

3. Change the Working range’s From field to 1.00 rpm. This prevents the counter from counting 

when the conveyor is off (0 RPM).  

 

4. Select the Counters tab. 
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5. Right-click an empty area of the tab and select New counter > Analogue runtime. 

 

6. The counter is displayed in the detailed view. In the Configuration tab, change the Name of the 

counter to Conveyor_Run_Time or similar in the Identification section. In the Configuration 

section, ensure that the conveyor speed trigger is selected.  

  

7. Save the project.  

8. Write the parameter to the diagnostic device. Ignore the warning.  
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9. Open the counter monitoring window.  

 

10. The window opens. Select table view.  

 

The counter is at 0.00, because the conveyor has not been turned on since the counter was 

configured.  

  

 Note: If the counter is not visible on the table, select it from the left-side menu.  

11. Turn the conveyor on. Observe how the counter increases.  

 

 Note: 0.01 hours is equivalent to 36 seconds.  

12. Let the conveyor run for several minutes and then turn it off.  

13. Right-click the counter row, and in the dialog menu, select Set counter values.   
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The set counter values window is displayed. The default value for resetting a counter is 0 h.  

 

14. Select the Write checkbox next to the counter.  

 

15. Click Write counters.  

 

16. In the popup, click Yes.  

 

The counter is reset to 0 h. 
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14.3.5. Linking a Counter to an Alarm 

You will now create a second counter. This counter will count how long the conveyor motor is below the 
lower limit and will be linked to a new alarm.  

1. Keep the conveyor running and return to the parameter tab.  

 

2. Select the Counter menu if it is not already selected.  

 

3. Right-click an empty area of the tab and, in the dialog menu, select New counter > Object state.  

 

4. The counter is displayed in the detailed view. In the Configuration tab, change… 

a. the name to Motor_Low or similar,  

b. the object to the conveyor speed lower limit, and  

c. the state to Warning.  
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5. In the Alarming tab, set the Limit to 0.05 h (3 minutes) and the Alarm group to Alarm group 1. 

This means that the alarm will turn on when the conveyor speed is below the lower limit for 

more than 3 minutes.  

 

6. Select the Alarm menu.  

 

7. Right-click an empty area of the tab and select New alarm > Counter.  
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8. The alarm is displayed in the detailed view. Give the alarm an appropriate name, change the 

output to Virtual Output 2, and change the switch to Normally open.  

 

9. In the Source tab, select Alarm group 1.  
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10. Save the project.  

11. Turn the conveyor on.  

12. Write the parameter to the diagnostic device.  

 

13. Open the counter monitoring window.  

 

14. Reset both counters to 0.   

15. Open the I/O monitoring window.  

 

16. Select Virtual Output 2, which is the output of the alarm you just configured.  

 

17. Observe the I/O monitoring window in table view. Both alarms are off (Lo).  
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18. Turn the conveyor off. The first alarm turns on (Hi) almost immediately, because it has detected 

that the conveyor speed is below the limit.  

 

19. Wait 3 minutes. Alarm 2 now turns on because the counter has completed its 3-minute timer.  

 

20. Open the Counter monitoring window and reset all counters.  

21. Return to the I/O monitoring window. The second alarm is now off (Lo).  

22. If time remains, create additional timers and counters for your objects, including the upper 

temperature limit. You can also modify the custom alarm you created in Section 14.3.3 and add 

alarms for other objects by adjusting the logic in the Source tab.  
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14.3.6. The History Window 

The history window displays the internal memory of the diagnostic device and helps to visualize the 
development of measurements prior to a damage message. For example, was the rise in values 
progressive, or was it sudden? Information like this can help us determine the urgency for servicing the 
machine.  

In this task, you will experiment with some of the features of the history monitoring window. 

1. Select the parameter tab or double-click the parameter in the tree view.  

 

2. Select the History menu.  

 

The History menu is displayed in the detailed view. Here, you can choose what will and will not 

be recorded in the diagnostic device’s historical memory. You can also select the intervals at 

which specific items will be recorded. Leave the defaults for this task.  
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3. From the tool bar, open the history window.  

 

The window is displayed in the detailed view. There may be many lines and it is difficult to make 

out what is happening (or what has happened, to be more precise). 

 

4. Open the left-side menu.  
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5. Uncheck all the elements. This clears the lines from the graph.  

 

6. Check the conveyor speed and temperature values.  
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7. Observe the graph. You should see two lines, one corresponding to the speed history, and the 

other corresponding to temperature history. Refer to the left-side menu to see which colored 

line refers to which measurement. For example, in the image below, the blue line is the speed 

value history, and the orange line is the temperature value history. You can see the temperature 

increases when motor speed increases. There is also a rising trend in the temperature value. 

 

 Note: The green and red lines are the warning and damage limits, respectively, for the 

temperature value. 
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8. Note that this history is a long-term history. On the X-axis, time is measured in days. (The vertical 

axes are the speed and temperature measurements). Click and drag the time axis left and right 

to see the older history and the most recent history.  

 

9. You can also see a more detailed history of a certain event. Click and drag over a small area of 

the graph to create a box.  

  

The graph zooms in on that area of the graph, and the scales of the axes change accordingly.  
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10. Right-click the temperature line to open a context menu. In the menu, select Measurement 

cursor.  

 

11. Move your cursor along the temperature line to see the exact measurement at a given time. The 

measurement is displayed at the top of the screen.  
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12. Right-click the temperature line again and select Measurement cursor to hide the crosshairs.  

 

13. Right-click an empty area of the graph and in the context menu, select Undo zoom.  

 

14. In the left-menu, select the “Values” for all objects linked to the sensor on the radial side of the 

motor perpendicular to the direction of the conveyor.  
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15. Investigate the graph and try to find any trends or anomalies.  

 

16. Hide the objects for the sensor and check the objects for the other three acceleration sensors. 

Can you infer anything from their history? 

17. Save and exit VES004.  
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14.4. EPILOGUE: HOW REAL INDUSTRIAL CBM WORKS 

Over the course of this experiment guide, you hopefully got a feel for what CBM is and for the types of 
machine faults and defects that CBM experts investigate. However, even though you were able to 
measure sensor data from your machine and interpret the results, the actual running of your machine is 
unlike that of a true industrial setup. In most industrial machine setups, once the machines are 
commissioned, they are supposed to run nonstop for weeks, months, or even years without any issue.  

Industrial CBM can be broken down into three categories or periods: commissioning, normal operation, 
and alarm diagnosis: 

14.4.1. Commissioning 

A CBM system is commissioned by performing the following steps: 

1. Installation: Sensors, automation controllers (PLCs), and any other diagnostic or supervisory 

equipment are mechanically and electrically installed. An analysis of the machine itself and its 

components will help determine where specifically the sensors will be placed.  

2. Perform initial diagnosis: Determine how old the machine and its components are.  

3. Configure the CBM setup and set its initial parameters: These parameters may be changed later 

(step 5 below). The parameters include sensor threshold values (warning and damage) limits. If a 

sensor value goes above an upper threshold or below a lower threshold, the system should 

return an alarm.  

4. Test operation: Data is gathered for a period of 3-4 weeks. Engineers will observe the sensor 

values and try to find trends.  

5. Parameter optimization: Using the test data, the parameters are optimized. In our example, one 

of the parameters we may have optimized was to increase the upper temperature limit, as 35 C 

(95 F) was too low of a value.   

14.4.2. Normal Operation 

After commissioning, the machine is in normal operation. This period is all about two things: 

• Monitoring for alarms. 

• Trying to understand the data and looking for trends over time that can help diagnose future 
alarms. For example, did a certain sensor value increase slowly over time? Was there a sudden 
increase? 

14.4.3. Alarm Diagnosis 

If there is an alarm, the CBM system and its technicians enter the alarm diagnosis stage. There are 
several steps here: 

1. Find the source of the alarm.  

2. If the data or trends from normal operation are not enough to discover the problem, the raw 

data and spectra might have to be examined, and additional analysis must be carried out to find 

the root cause. 
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3. Match any experience you have with statistical KPIs such as MTBF. 

4. Ensure that the issues and their resolutions were properly reported.  

5. If necessary, adjust the monitoring parameters. For example, if you have found a new indicator, 

adjust the monitoring parameters accordingly. 

14.5. REVIEW QUESTIONS 

1. Which of the following statements about the historical chart below is/are true? 

 

a. The trend is stable 

b. The trend is unstable.  

c. The trend is rising. 

d. The warning limit has been reached.  

e. The damage limit has been reached. 

2. Alarm output is shown on the:  

a. Spectrum monitoring window. 

b. I/O monitoring window.  

c. Raw data monitoring window. 

d. History window.  

3. Which of the following statements about the history window are true? 

a. The objects to be displayed on the graph can be selected from the left-side menu.  

b. The x-axis is frequency, and the y-axis is the measured object value.  

c. All objects are represented by a differently colored line.  

d. You can zoom in on the graph to see specific points in time. 
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4. Regarding a CBM commissioning period, monitoring parameters: 

a. Should be set once at the beginning and never changed.  

b. Should be set at the beginning and optimized after a test period.  

c. Should be set once at the end and never changed. 

d. Should be set for the first time after the commissioning period and then should be optimized 

again after an alarm. 

5. Testing during a CBM commissioning period should have a time length of: 

a. Several weeks 

b. Several months 

c. Several days 

d. Several hours 

6. Select all correct answers. Which of the actions regarding CBM alarm diagnosis should be 

performed by CBM technicians? 

a. Find the source of the alarm using raw data. If that is insufficient, use historical trends.  

b. Find the source of the alarm using historical trends. If that is insufficient, use raw data. 

c. Report any issues and how they were resolved.  

d. Adjust the monitoring parameters if necessary. 

Answers 

1:b&c 2:b, 3:a,c&d, 4:b, 5:a, 6:b,c&d 
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15. Coming Attractions 
Thank you for taking the time to experiment with Condition-Based Monitoring with the Intelitek CIM 
System! 

If you enjoyed working with the smart sensors and the VES004 software and you had fun learning about 
how to find different problems in industrial machines, then you should check our Mechanical Training 
(ME) Series. The ME Series with the JobMaster Mechanical Bench will teach you all about how to 
maintain your machines as well as repair them if a breakdown occurs. In addition, our new course, CBM 
for Industry 4.0 with the JobMaster Mechanical Bench delves further into the world of machine-
condition monitoring, and allows you to introduce, detect, and resolve many more different types of 
machine faults, such as coupling misalignment, resonance, electrical unbalance, bent shafts, bearing 
damage, and more!        

Go to https://intelitek.com/mechanical-systems/ for more information.  

 

Intelitek’s JobMaster Mechanical Bench  

https://intelitek.com/mechanical-systems/
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